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Important Notice:
A basic ARGUS package includes at least a DSL interface (ADSL or VDSL) together with 
various related functions and tests. Support for other interfaces and functions is optional 
(see the Options in the data sheet). Consequently, depending on the scope of the functions 
delivered, certain menu items may be hidden.
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1 Introduction
1 Introduction

The ADSL+VDSL and service tester

Fast testing guaranteed: the ARGUS®141 xDSL Tester focuses on the key functions for 

testing VDSL2, ADSL and Ethernet and is ready to operate extremely quickly. 
The user-friendly handheld tester is able to integrate both interfaces in a single device. 

Modern chip sets for ADSL and VDSL2 ensure optimum performance, thus providing a 

high level of interoperability and a long reach. The results are presented both in tabular or 

graphical form.


Future-proof testing

Well equipped for the future: as an option, the ARGUS®141 can be upgraded to test Voice 

over IP (VoIP) and data services such as ping, trace route or download (HTTP, FTP) and 

upload (FTP) via xDSL and Ethernet – this upgrade is even available after purchase.


Testing of services: Voice over IP (VoIP)
During VoIP testing, the MOS value is also calculated automatically. As a lineman’s 

handset, the ARGUS®141 simulates terminal equipment such as a phone or replaces a PC 

and determines the relevant quality parameters. 
intec also supply the checker with bridge or router functions to test customer modems.


Spectrum analysis
Using the DMT Analysis functionality, the user can analyse – in a low-impedance mode – 

the spectrum of the entire xDSL bandwidth (up to 30 MHz) and locate faults.


Easy Operation

The ARGUS®141 is extremely user-friendly thanks to its bright 320 x 240 pixel colour 

display and long-life Lithium-Ion battery pack, which can be replaced in the field.

Software updates can be downloaded to a PC free of charge and then loaded into the 

ARGUS at any time. They are available at http://www.argus.info/en/service/downloads/.
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1 Introduction
An overview of a few of the important ARGUS functions:

xDSL tests (ADSL, ADSL2 and ADSL2+, VDSL2)

- Synchronisation with the DSLAM (xTU-C) and determination of all relevant 
connection parameters and error counters

- Bridge, Router and Terminal Modes

Ethernet interface

- 1 Ethernet test interface (10/100 Base-T), RJ-45

IP and ATM tests via xDSL and Ethernet

- ATM tests (ADSL only)

- ATM OAM ping, ATM OAM cell loop and VPI/VCI scan

- IP tests

- Ping and trace route tests (BRAS information, PPP trace and VLAN)

- Download tests to determine throughput (HTTP download, and FTP upload and 

download)

- FTP server test, upload and download from ARGUS to ARGUS

- VoIP test

- VoIP terminal simulation, including acoustics (various codecs)

- OK/FAIL evaluations and display of the quality parameter

- Evaluation of the VoIP voice quality (QoS) in accordance with:
- MOSCQE (ITU-T P.800), E-Model (ITU-T G.107)

- IPTV tests

- Stream requests (STB mode), IPTV channel scan, IPTV passive

- OK/FAIL evaluations and display of the quality parameter

Copper Test functions (Copper Tests)

- DMT Analysis: Analysis of the Power Spectral Density (PSD) and the noise of up to 
4096 tones (e.g. VDSL2 Profile 30a).

Access acceptance report

When the ARGUS is connected to a PC via USB, it is, as an example, possible - with the 

aid of the WINplus software - to create a comprehensive test report on the PC and print it.
ARGUS 141 7



1 Introduction
The Concept of the ARGUS Firmware User Interface
The ARGUS firmware presents - on a graphic Status screen - the results of tests made with 

the latest in measurement technology. In this manner, all of the important processes can be 

shown on a single screen together with main sequences with all the convenience and 

transparence to which ARGUS users are accustomed. 

In this manner - with its intuitive menu structure - the ARGUS makes it easy to not only 
configure, start and perform tests but also to examine the test results:

You will find other important information about profile structures on our website.

Should you have any further questions, please contact us:

intec Gesellschaft für Informationstechnik mbH
Rahmedestr. 90

D-58507 Lüdenscheid
Tel.: +49 (0) 2351 / 9070-0

Fax: +49 (0) 2351 / 9070-70
www.argus.info/en

support@argus.info

- The physical layer - Layer 1 (e.g. DSL) - can be started and stopped completely 
independently of the higher layers such as Virtual Lines (L2/3), services or tests.

- Layer 2 (VLAN, VPI/VCI) and Layer 3 parameters (PPP, IP) are combined in 
independent Virtual Line profiles (VL profiles). Multiple VL profiles can be configured 
and started on a single DSL access. It is also possible to bridge and route multiple 
Virtual Lines concurrently.

- Thanks to the introduction of services between the Virtual Lines (VLs) and the Data, 
VoIP and IPTV tests, it is now possible to take an incoming call even when the ARGUS 
is used as an IP phone with VoIP activated.
8 ARGUS 141 

www.argus.info/en
www.argus.info/en


2 Safety Instructions
2 Safety Instructions

The ARGUS may only be used with the included accessories. Usage of other accessories 

may lead to erroneous measurements and may even cause damage to the ARGUS and the 

connected installation. The ARGUS is only to be used in accordance with the instructions in 

this documentation. Any other usage may result in bodily injury and destruction of the 

ARGUS.

- Before connecting the ARGUS to an access make certain that the voltages on 

the access are not high enough to be dangerous or outside the specified 

range of the ARGUS or its accessories. You must also taken into account the 

fact that the voltage may vary while the ARGUS is connected to the access.

- Regardless of the interface or access, use the ARGUS only for its intended 

purpose.

- Voltages in excess of 50 V AC or 120 V DC can cause mortal injury.

- Never attempt a measurement when the battery pack (accumulator) is not 

installed!

- The ARGUS is not watertight. Protect the ARGUS from exposure to water!

- Before replacing the battery pack, disconnect all the test leads and switch the 

ARGUS off.
CAUTION: Never remove the battery pack during operation.

- Unplug the power supply from the mains, once the ARGUS is switched off 

and will no longer be used (for example after recharging the accumulators)!

- The ARGUS may only be used by trained personnel.

- Do not operate the ARGUS on a power supply that has other specifications. 
The specifications are:
 (Input: 100 V to 240 V AC; 50/60 Hz 0.45 A)
 (Output: 12 V DC; 1.5 A)

- The ARGUS Power jack must always be covered with the included rubber 

cap (labeled "Power") while operating in battery mode.

- The electromagnetic compatibility of the ARGUS was checked in accordance 

with the regulations stated in our Declaration of Conformity.
This is a Class A device. It may cause radio interference in a living area. In 

this event, the operator may be requested to take appropriate measures.

- The ARGUS battery pack may only be actively charged (Charge battery) or 

trickle charged (default setting: on) when the ambient temperature is between 

0 °C (32 °F) and +40 °C (104 °F).
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2 Safety Instructions

Return and Environmentally Acceptable Disposal

The RoHS (EU Directive on the “Restriction of Hazardous Substances”) guidelines, which 

restrict the use of certain hazardous substances in electrical and electronic equipment, 

apply in eight of the ten categories of the WEEE (EU Directive on “Waste Electrical and 

Electronic Equipment”) guidelines. Devices which are in Category 9 “Monitoring and 

Control Instruments” are currently excluded from the scope of the Directive. The ARGUS 

products fall into Category 9 and are thus not subject to the RoHS guidelines. Nonetheless, 

we have voluntarily complied with all of the RoHS guidelines since 1 January 2007.

In compliance with WEEE (EU Directive on Waste of Electrical and Electronic Equipment) 

2002/96/EU and the German Electrical and Electronic Equipment Act (ElektroG - Elektro- 

und Elektronikgerätegesetz), we began marking our testers in October 2005 with the 

following symbol:

 ( ) (DIN EN 50419).

In other words, the ARGUS and its accessories may not be disposed of in the household 

waste. Regarding the return of old equipment, please contact our Service department.





- If the ARGUS is operated under extreme conditions, it may have to 

automatically shutdown, terminate the current test and drop the connection in 

order to protect itself and the user. 
To ensure reliable long-term operation of the ARGUS, make certain that it is 

protected from excessive temperatures.

- Do not open the tester.

- In connection with the lithium ion battery pack, please observe the following 

notes regarding safety and transport.

- Before running a test or synchronizing on an interface, determine how the 

ARGUS should be powered.
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2 Safety Instructions
2.1 Notes on Safety and Transport - Battery Packs

Transport

The battery pack has been tested in accordance with the UN recommendations (ST/SG/
AC.10/11/Rev. 4, Part III, Subsection 38.3). Protective measures have been implemented 
to prevent harm if it is exposed to excessive pressure, short-circuits, dangerous reverse 
currents or other destructive influences. However, since the amount of lithium contained in 
the battery pack is in any case less than the current threshold amount, neither the battery 
pack itself nor the ARGUS in which it is installed are subject to the international hazardous 
goods regulations. Nonetheless, these regulations may apply if several battery packs are 
transported at the same time.For more information, please contact us.

The protective features of the battery pack may be harmed if the following 
instructions are not observed. In this case extremely high currents and 
voltages may result, which could lead to abnormal chemical reactions, 
leaking acid, overheating, smoke, or an explosion and/or fire. Furthermore, if 
the user does not observe and comply with these instructions both the 
performance and service life may suffer.


Safety Instructions and Warnings

1. Do not disassemble or short-circuit the battery pack.

2. Do not throw the battery pack into a fire or heat it (> 60 °C) (140 °F).

3. Keep the battery pack dry - do not let it get wet or damp.

4. The ARGUS battery pack may only be actively charged (Charge accus) or trickle 

charged (default setting: off) when the ambient temperature is between 
0 °C (32 °F) and +40 °C (104 °F). 
To maximize a battery pack service life, if it is to be stored over a longer period of 

time, it should not be exposed to temperatures in excess of +50 °C (95 °F).

5. The battery pack may only be charged using the associated ARGUS or a charger 

approved by intec.

6. Do not damage the battery pack with a sharp object.

7. Do not throw the battery pack or expose it to shocks or impacts. 

8. If a battery pack is damaged or deformed, do not use it.

9. Like any battery, the battery pack has two poles (plus and minus). To prevent 

damage, make certain that it is correctly connected (polarity) to the ARGUS or 

charger. 

10. The battery pack may only be connected to the associated ARGUS or charger in 

the intended manner.

11. The battery pack may not be directly connected to the output of a plug-in power 

supply, an automobile cigarette lighter or similar power source.

12. The battery pack may only be used together with an ARGUS.

13. The battery pack may not be connected to, or stored or transported with metallic 

objects.
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2 Safety Instructions
14. Do not expose the battery pack to high electrostatic forces.

15. The battery pack may not be used in combination with primary (non-

rechargeable) batteries, nor may it be charged or discharged together with other 

rechargeable batteries.

16. If the battery pack is still not properly charged when the charging time has 

elapsed, do not charge it again.

17. Do not expose the battery pack to excessive pressure.

18. If the battery pack emits an odor or heats up, becomes discolored or misshapen, 

or if there are any other indications of that it has malfunctioned while in use or 

being charged or stored, remove the battery pack from the ARGUS or charger 

immediately and do not use it again.

19. If the battery pack leaks acid, make certain that you do not get this acid in your 

eyes or on your skin. In event that you get this acid in your eyes or on your skin, 

rinse the affected area immediately with clean water. Do not rub the affected area. 

In either case, immediate medical care is required. Otherwise, permanent injury 

may result.

20. The battery pack must be kept out of reach of children.

21. Please read this manual and the associated safety instructions before using the 

battery pack.

22. If you find that the battery pack emits an odor, is rusty or appears to be in anything 

other than perfect condition before you first use it, please contact intec to 

determine how to proceed.
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3 General Technical Data

ARGUS user safety tested in accordance with EN60950-


RoHS conformity pursuant to the WEEE guidelines
The electromagnetic compatibility of the ARGUS was 
checked in accordance with the regulations stated in our
Declaration of Conformity.


CE symbol 
The ARGUS 141 conforms with the EU Directive 2004/
108/EC as well as 2009/C197/03. We would be happy to
supply you with a copy of the detailled Declaration of Con
formity upon request.

Tester specifications:

Dimensions / Weight Inputs / Outputs

Height: 235 mm (9.25 in)
Width: 97 mm (3.8 in)
Depth: 65 mm (2.56 in)
Weight: approx. 710 g (1.57 lbs)
(including battery pack)

- RJ-45 (Line) for xDSL and Copper Tests

- Ethernet 10/100 Base-T
- USB-B jack, USB Client interface

Keypad

25 Keys

LCD display Temperature ranges

LCD color display with 

switchable 
background lighting,
320 x 240 pixels

Temperature range - charging batteries: 
0 °C (+32 °F) to +40 °C (+104 °F)
Operating temperature (in battery mode):
-10 °C (+14 °F) to +50 °C (+122 °F)
Operating temperature (with power supply/car adapter): 

0 °C (+32 °F) to +40 °C (+104 °F)
Storage temperature: -20 °C (-4 °F) to +60 °C (+140 °F)
Humidity: up to 95 % relative humidity, non-condensing

Power supply

Lithium ion battery pack, rated voltage 7.2 V
(observe and comply with the safety instructions)
or 12 V / 1.5 mA ARGUS electronic plug-in power supply

Other information
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3 General Technical Data
Supported Standards:

ADSL (Line):
ITU-T G.992.1, Annex A (ADSL)
ITU-T G.992.2, Annex A (G.lite)
ITU-T G.992.3, Annex A (ADSL2)
ITU-T G.992.5, Annex A (ADSL2+)
ITU-T G.992.1, Annex B (ADSL)
ITU-T G.992.3, Annex B (ADSL2)
ITU-T G.992.5, Annex B (ADSL2+)
ITU-T G.992.3, Annex J (ADSL2)
ITU-T G.992.5, Annex J (ADSL2+)
ITU-T G.992.3, Annex L 
 (RE-ADSL2 over POTS)
ITU-T G.992.3, Annex L 
 (RE-Narrow PSD ADSL2 over POTS)
ITU-T G.992.3, Annex M (ADSL2)
ITU-T G.992.5, Annex M (ADSL2+)
ANSI T1.413
ETSI TS 101 388 Annex C



Dielectric strength:




Line:
DC voltage: +200 V max.
Alternating Current (AC): 100 Vpp max.

   (Copper Tests only)
DC voltage: +200 V max. (xDSL)

VDSL (Line):
ITU-T G.993.2 (VDSL2)
Profile:
8a, 8b, 8c, 8d, 12a, 12b, 17a, 30a

Ethernet (LAN):
IEEE 802.3  
- 10 Base-T 
- 100 Base-T
Autonegotiation
Auto-MDI(X)
14 ARGUS 141 



4 Operating Instructions
4 Operating Instructions

LEDs

Softkeys

Cursor keys

Confirmation key

Level key

 

Telephony: Pickup / Hang up

Power

Microphone Fastener for shoulder strap

Numerical keypad

LC display

Return key

Shift key

Speaker

Power key

-
-
-



-




Switch the ARGUS on
To start up again after a "power down" (adjustable see page 203)
To switch on the display backlighting (can also be done by pressing any 

other key). In battery mode to save power, the backlighting will switch off 

automatically after an adjustable period of time - see page 204.
To switch off the ARGUS (must be pressed somewhat longer)
After being idle for an adjustable period of time (for example after 10 

minutes), the ARGUS will shutdown automatically if it is running in 

battery mode (see page 208). If the ARGUS is connected to its power 

supply, it will automatically charge its accumulators when it is switched 

off (see page 208 Using the Battery Pack).

Confirmation key

-
-
-
-

Open menu
Open the next display
Start test
Confirm the entry
ARGUS 141 15



4 Operating Instructions
Return key

-

-
-

The ARGUS will return to the previous display and ignore any entries 

made at this level, e.g. changes to the settings 
Cancel test
Close the graphic display

Cursor keys

-
-

-


-
-
-
-

Scroll through the display line-by-line (vertical cursor keys)
Move the cursor within a displayed line
 (horizontal cursor keys)
When viewing a selection list or statistics, the cursor will jump to the 

end of the list/statistics if the right cursor key is pressed or to the 

beginning if the left cursor key is pressed
Select a menu, function or a test
Setting the measurement range in a Copper Test
Move the cursor in a graphic display
Select functions in the graphic Status screen

Telephony

xDSL (access mode xTU-R, xTU-R Router) and Ethernet 

- Start VoIP telephony

Level key

-
-
-

xDSL access: Display the results
Ethernet: Open the results
Open the graphic Status screen

Numerical keypad

-
-





Entry of the digits 0 to 9, letters and special characters
Direct access to functions appropriate for the selected Access (Hotkey), 

e.g. page 106 et seq.
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4 Operating Instructions


The ARGUS is in largest part operated with the 4 cursor keys, the confirmation key  , 

the return key , the level key , and the three softkeys.

The current assignment of the three softkeys is shown in the lower line of the display.

On the following pages, only the softkey's meaning in the respective context is shown - 

enclosed in angle brackets < >, e.g. <Menu>. The < > softkey serves the same function 

as the confirmation key , the <> softkey performs the same function as the cursor 

key  on the ARGUS keypad, and so on.

Softkeys

-




-

The function of the 3 softkeys varies with the situation. The current 

assignment of each is displayed on the bottom line of the display in 

three blue blocks with white text, e. g.:
<Menu>: The Main Menu will open

<Start>: Setup a connection or start a test


You will find the other softkeys described at the relevant points in the 

manual.

Shift key

In some menus, a green circle with a green “S” will be shown in the 

uppermost line in the display. This indicates that the softkeys are 

assigned twice. In such a case, press the Shift key to change the 

function of the softkey (for an example, see page 175).

Example 

Press the Shift key: the function of the 
softkey will change accordingly.
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4 Operating Instructions
Example of operation:

Current assignment of the softkeys

Press <No>: The displayed access will 

not be used. The Access Menu will open.

Using 

the 

Select a line in the display:
in this example, select a type of 

access; the selected type will 

marked in blue
(in this example: ADSL).

Using 

the 

Confirm the selection: 
in this example, the ARGUS will 

set the type of access to the one 

marked in blue. The Access Menu 

will open.

Using 

the 

Return to the previous display 

without changing to marked type of 

access.

Header: Shows the name of the menu (in this 

example, the Access Menu), the name of the 

currently running test etc.

Continuation on 

next page
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4 Operating Instructions
















<Profile> Displays the profile, see 
page 30

<Menu> Open the Main Menu

<Start> Start the ADSL connection

<Edit> Open the xDSL and Ethernet 
settings

<Profile> Configure profile

<Start> Start the ADSL connection
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4 Operating Instructions
Access up

Access down

PWR

Connection for the external plug-in power supply.
If the plug-in power supply is connected, the 

ARGUS will automatically disconnect the 

accumulators (battery pack). After it is switched off,

the ARGUS will automatically recharge the 

accumulators (see page 208).

USB-B (mini-USB):

USB Client interface (PC connection)


Yellow “Link/Data” LED:
signals that a physical connection has 

been established to another Ethernet 

port

- LED on constantly: 
A connection has been setup.

- LED flashing: Active - sending or 

 

Line

Access xDSL
Access Copper

Pin assignment: 4/5
Pin assignment: 4/5

LAN

Connection to a PC's network card
Connection to the Ethernet interface of an
xDSL modem, router (IAD) or a hub, switch or 
other Ethernet interface (Access: Ethernet).

Green "Speed" LED:
signals the transmission speed 

- LED off: 10 Base-T
- LED on: 100 Base-T
20 ARGUS 141 



4 Operating Instructions
Charging the battery (accumulator) for the first time

The compartment for the rechargeable battery pack (accumulators) is located on the back 

of the case. Insert the battery pack with the locating lug at the top and then tighten the 

thumbscrew. Use only the battery pack included in the package. With the ARGUS switched 

off, connect it to the supplied plug-in power supply.

Press the -key to switch the ARGUS on. The following display should appear (it may 

be necessary to first acknowledge other displayed notices):



The supplied battery pack will not reach its full capacity until it has been fully charged (see 

page 208 Using the Battery Pack).

Current assignment of the softkeys

Press <Battery>

 Press

Once the battery pack has been fully charged, 

the ARGUS will indicate this in the display.

 Press: Cancel "Charge" battery pack

The access and mode shown 

may vary.

Selected
menu item

Menu name
ARGUS 141 21



4 Operating Instructions
Power management

In battery mode, the ARGUS will automatically power down after it has been idle for 

5 minutes (this setting can be changed, see page 204). Reasonably enough, the 

ARGUS will not power down during a test (e.g. Loopbox) or when it is in Trace 

mode.

As an alternative, it is possible to operate the ARGUS using the included plug-in power 

supply. When the power supply is connected, the accumulator is automatically 

disconnected. Regardless of whether the power supply is connected, the accumulator 

should always installed using the ARGUS. This will ensure, among other things, the 

uninterrupted operation of the real-time clock.

Unplug the power supply from the mains, once the ARGUS is switched off and will 

no longer be used (Battery charging).
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4 Operating Instructions
An Overview of the ARGUS Connections
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5 Menu Hierarchy
5 Menu Hierarchy

     Menu
   Access

Selection of the physical 

access

The Access Menu will open 

automatically

Switch the ARGUS ON

The main window will open displaying menus 

available for the type of access selected last (see 

page 25, "Single Tests" menu).

ADSL page 27

VDSL page 60

...

and so on page 76 

        Menu 
Accu Servicing

Charging page 209

Trickle charge page 209

The initial display will depend on the 

type of access set last. 
In this example: ADSL access

and
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5 Menu Hierarchy
e.g. ADSL

          Menu
    Access mode

Selection of the Access 
Mode, e.g. xDSL 
or Ethernet

VDSL

ATU-R page 35

ATU-R Bridge page 53

VTU-R page 62

VTU-R Bridge page 70

Further page 76

        Menu
   Single Tests

IP ping page 120

Further page 127

For more information regarding the Menu Hierarchy, please 
see the included detailed menu diagram. The current menu 
diagrams can also be found under www.argus.info/en.


To open the ARGUS State Display, press


the Level key       .  .


The State Display is the one from which 
all other steps are taken.
ARGUS 141 25
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6 The Physical Layer

The physical layer (Layer 1) is shown in the Status screen (figure 2) with its own graphic 

element (in this example ADSL). The other elements in the Status screen will at first only be 

mentioned. For a detailed description of these, please see page 82 (Virtual Lines) and page 

102 (Services). The physical layer of a VDSL or Ethernet access will be displayed in the 

same manner as for an ADSL access. The ADSL access and the Access mode ATU-R 

selected are shown in the Status screen directly. If the default settings are correct, Layer 1 

(ADSL synchronisation) can be setup immediately by pressing <Start>. The most 

important information, e. g. voltage (U), modem states (Power down) and selected 

configuration (Annex A auto), will be displayed in the Layer 1 box (blue). If you wish to 

change the ADSL access parameters directly, press <Edit>. To change the type of access 

directly from the Status screen (Figure 2), press the key combination  and .




























For information on tests that can be performed on Layer 1, see page 104.

Services, 
see page 102

Layer 1

Router / Bridge 
(xTU-R Bridge and 
xTU-R Router only)

Virtual Lines, 
see page 82

Profile name

Current 
assignment of 
the softkeys

Press the Level key

see page 31 see page 30 see page 36

Figure 2 (example, ATU-R Router):

Figure 1

<Edit> Edit the ADSL 
settings

<Profile> Profile selection

<Start> Synchronisation



7 Operation on an ADSL Access
7 Operation on an ADSL Access

The ARGUS supports the following types of access (access modes): 

The individual ADSL tests record and store data (e.g. in tracing IP data). The user 

must comply with the statutory regulations governing the collection and storage of 

such data and his obligation to give notice in this connection.

The voltages on the subscriber line may not exceed 200 VDC and should be free 

of AC voltage.

ATU-R Terminal mode (ADSL Transceiver Unit Remote - ATU-R), see page 35.
Connection of the ARGUS directly to the ADSL access (before or after 

the splitter). The ARGUS replaces both the modem and the PC.

ATU-R Bridge Bridge mode (ADSL Transceiver Unit Remote Bridge), see page 53.
Insertion of the ARGUS between the ADSL access and the PC. The 

ARGUS replaces the ADSL modem.

ATU-R Router Router mode (ADSL Transceiver Unit Remote Router), see page 57.
Insertion of the ARGUS between the ADSL access and the PC. The 

ARGUS replaces both the ADSL modem and the router.
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7.1 Setting the ADSL Interface and Access Mode

Use the included xDSL cable to connect the ARGUS (Line jack) to the access to be tested 

and then switch the ARGUS on. The initial display will depend on the access setting used 

last. Select ADSL as the type of access and ATU-R as the access mode.

The various submenus available for the selected 

type of access are shown in the Main Menu.

 
Opens the marked menu (in this 
example, Single Tests).

 

Select a menu. The selected menu 
will be marked blue in the display.

 to return to the previous menu (in the 
example, the State Display).

ARGUS State Display

Main Menu

Items displayed (from top to bottom):

Access mode (in the example: ATU-R)

- Default (preset) profile (in the example: Profile 1)

- Status (in the example: Power down)

- DC voltage on the interface

The ADSL test is not yet started:

Key to the LED symbolized in the display:

Red LED no test started

Yellow LED test started

Green LED A connection has been setup.

<Menu> Open the Main Menu.

<Profile> Display the profile, see page 30.

see page 36

Note:
Starting functions with the numeric keys / key combinations
The ARGUS keypad can be used to call up or start the main functions and/or tests directly. 
An overview of the available key combinations can be found on page 106.
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7.2 ADSL Settings

The ARGUS stores all of the settings required to run a test on an ADSL access in profiles. 

Up to 10 user-defined profiles can be created. A specific profile can be selected before an 

ADSL connection is setup or a test performed, otherwise the ARGUS will use the default 

(preset) profile. Only those settings which are relevant will be used for the respective test 

situation. The default settings can be restored at any time (see page 205). The procedure 

for changing a setting will be illustrated with a single example:

ARGUS - State Display ARGUS - Main Menu

Continuation on 

next page

Shortcut to the ADSL settings.
Continuation on page 31, 
Display 2.

ARGUS - Status screen
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Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile will 
be marked in the display with a . 
The ARGUS will use the settings in 
the default (preset) profile when 
setting up the ADSL connection.

The ARGUS will use the marked 
profile as the default profile and will 
open either the State Display, the 
Status screen or the Settings menu 
(depending on whether the profile 
was opened from the Main Menu, 
the Status display or the ARGUS 
State Display).


e.g. select Access parameters

Bridge/Router settings, see page 33

Test parameter settings, beginning on 
page 108


e.g. select the Phys. parameters

Continuation on 

next page
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Continuation of the <Edit> shortcut on 
page 29.












The ARGUS uses the marked ADSL 
mode as the default and returns to 
the next higher menu.

Select ADSL mode (in the example, 
Annex A auto). The default setting will 
be marked in the display with a .











e.g. select ADSL


e.g. select ADSL mode

Open the next higher menu 
without making any changes. The 
ARGUS will continue to use the 
default setting.
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Setting Explanation

Access parameters:

Phys. parameters:

ADSL: Access parameters for the ADSL connection

ADSL mode Different ADSL modes can be selected depending on the variant of the 

ARGUS. The selected ADSL mode must be compatible to ATU-C 

(network-side). If an ADSL auto-mode is selected (Annex A/M auto, 

Annex B/J auto, Annex A auto, Annex B auto or Annex M auto), the 

ARGUS will automatically determine the configuration at the DSLAM 

and make the corresponding settings. 
Default setting: Annex A auto

Annex B 
firmware

Select the version in the ADSL Annex B firmware. 
Releases R4 and R5 are available to choose from.
For more information, please contact us.
Default setting: R4

Rated value Use the keypad to enter the upstream and downstream comparison 

values for the ATM bitrate [kbit/s]. If the current bitrates on the ADSL 

connection exceed the rated (threshold) values, the ARGUS Status will 

show "OK“, otherwise "FAIL“ will be displayed.
Default setting: d: 0 and u: 0

INP/SNRM Determines how any free line capacity will be used by a connection. 
Favour DS INP: The downstream INP will be increased to a value 

greater than the minimum INP set for ATU-C. 
Favour DS SNRM: The downstream SNRM will be increased to a value 

greater than the DS Target SNRM set for ATU-C. 
Whether the free line capacity can be used will depend on ATU-C and 

its configuration. 

Default setting: Favour DS INP
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7 Operation on an ADSL Access
MAC address:

Display and selection of the MAC addresses. 
The first two MAC addresses cannot be changed manually.

1. If the default MAC address is selected, the ARGUS will use its own 

MAC address. 

    Default setting: Default MAC address

2. If Dynamic MAC Address is selected, a different MAC address will 

be used for each synchronization.

3. A third MAC address can be entered: 
Mark a line and then press <Edit>. 

<Edit> Edit the MAC address for the entry.
Enter the address in hexadecimal from the keypad 

and the softkeys <A..F> (e.g. to enter a “C” press the 

softkey three times or for an “F” six times; conclude 

by pressing <OK> to confirm your entry). Group MAC 

addresses cannot be used.
Default setting: 00:00:00:00:00:00

Use the address.
The new address is only saved temporarily and will 

not be available when the ARGUS is switched on 

again.

One after the 

other 

 and

Displays the ARGUS MAC addresses:
Line, LAN, see also page 106 f.

Bridge/Router:

Ethernet:

Auto-
negotiation

Switch on or off
If autonegotiation is enabled, a network card can independently deter-
mine the correct transmission speed and duplex setting for the network 
port to which it is connected and can then configure itself accordingly. 
In the case of Ethernet, autonegotiation is based on Layer 1 of the OSI 
Model (in accordance with the IEEE 802.3u standard). 
Default setting: On (see page 79) 

IPv4:

IP mode Setting the assignment of the IP addresses 

Static IP: 
DHCP server: 

Static IP addresses
IP address assigned by ARGUS
Default setting: DHCP server 
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7 Operation on an ADSL Access
For information on other access parameters, see chapter 10 Virtual Lines (VL) page 82.

Local 
IP address

Own local IP address of the ARGUS
Range: 0.0.0.0 to 255.255.255.255
Default setting: 192.168.10.1 (see RFC 3330 regarding assignment)

IP netmask IP netmask
Range: 0.0.0.0 to 255.255.255.255
Default setting: 255.255.255.0 (see RFC 3330 regarding assignment) 

DHCP server Options for the DHCP Server:
- Start and End IP addresses
 Range: 0.0.0.0 to 255.255.255.255
 Default setting: (see RFC 3330 regarding assignment)
 Start: 192.168.10.30
 End: 192.168.10.40
- Name of the domain
- Reserve time of the IP addresses
 Range: 1 to 99999 hours
 Default setting: 240

Router:

NAT NAT (Network Address Translation) on or off
The Router’s NAT service automatically and transparently replaces the 

address information (e.g. the IP addresses of the LAN) with other 

address information (e.g. the IP addresses of the WAN).
Default setting: NAT on

SIP port The port used for the incoming SIP signaling. 
NAT on 0 to 65535 
Default setting: 5060
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7 Operation on an ADSL Access
7.3 The ARGUS in the ATU-R Access Mode

Determining the ADSL connection parameters
The ARGUS is connected directly to the ADSL access (either before or after the splitter) 

using the included xDSL cable or a patch cable. In this case, the ARGUS replaces both the 

modem and the PC. The ARGUS will set up an ADSL connection and determine all of the 

relevant ADSL connection parameters. The ARGUS displays the ADSL connection 

parameters and saves them after the connection is cleared down if desired.

Use only the cable included in the package!



Setting the ATU-R access mode:


ADSL access

















or 

 and  




ARGUS - Status screen

Line 

jack
ADSL access
ATU-C (DSLAM)

xDSL cable or patch cable 

ADSL

Access

Continuation on 

next page
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Setting up an ADSL connection 

Profile settings:

When setting up the ADSL connection, the ARGUS uses the settings saved in the profile 

(see page 31): ADSL mode, rated value, Annex B firmware and INP/SNRM.

ARGUS - Status screen








The ARGUS will use the default 

(preset) profile to setup the ADSL 

connection (in this example, 
Profile 1).

The ADSL test is not yet started: red 
LED in the display.

Key to the LED symbolized in the 
display:
Red LED no test started

Yellow LED test started

Green LED A connection has been 
setup.

All further functions and 
procedures will be explained on 
the basis of this Status screen.

Continuation on 

next page
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7 Operation on an ADSL Access
Display the profile. 

The default profile will be marked in 
the display with a  (in this 
example: Profile 1).

Setting up an ADSL connection

The ARGUS synchronizes with the 
DSLAM (the “Sync / L1” LED will 
flash and an element with a yellow 
background will be shown in the 
display).
The ARGUS will display the current 
connection status (in this example 
"Initialize") in the Layer 1 box (blue).





While setting up the connection:
Display:




Mark the profile. 

<Edit> Open the marked profile 
for editing.
The settings of the 
selected profile can be 
edited here (see page 30).

- Current connection status

- ADSL mode

- Time elapsed since the start of 
synchronisation in h:min:sec.

The ARGUS takes over the marked profile 
as the default and returns to the Status 
screen.

Continuation on next page

or
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7 Operation on an ADSL Access

Command symbols:






Display timestamp.




The ARGUS shows the time when 
(internal clock, see page 203) the 
command arrived.


< = command sent from the ARGUS

> = command sent from the DSLAM

- = connection status

Return to the previous display 
and the Status screen.
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Connection successfully setup

As soon as the connection has been setup ("Sync/L1" LED on constantly and a green 

check mark in the Layer 1 box), the ARGUS will determine the ADSL connection 

parameters. After the ARGUS has synchronized, it must remain connected to the ADSL 

access for at least 20 seconds. After this time has elapsed, the ARGUS will have saved all 

of the ADSL connection parameters.

ARGUS - Status screen.
Display shows (Layer 1 box):


If the current data rate exceeds the rated 
(threshold) value set (see page 32), the 
ARGUS will display a green "OK" in the 
ARGUS status (see page 28) otherwise it 
will show a red "FAIL". 


Display the ADSL connection parameters 
in brief: 
- d/n: downstream/near
- u/f: upstream/far

- Access and Access mode

- ADSL mode

- d: Downstream data rate
u: Upstream data rate

- Number of CRC errors in
downstream and upstream data

- Interface's DC voltage

<Info> Display the ADSL connection 
parameters

<Test> Display the available tests, see 
page 104

<Stop> Clear down the ADSL 
connection


Scroll through the 
connection parameters.

<Trace> Display the Trace data, see 
page 38.

<Graph> Display the graphs, see 
page 41.Continuation on next page

or

see page 104
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7 Operation on an ADSL Access
Display the connection parameters in long 
form for both downstream (d) and 
upstream (u), see table page 48.






Display ATM statistics:

ATM Cells:
The ARGUS will display the number of 
ATM cells received (Rx) and sent (Tx).

ATM Information:
The ARGUS will display the ATM 
information received (Rx) and sent (Tx) 
such as: 
- number of OAM cells
- number of user-side VCCs 
- number of AAL5 PDUs




Other ATM information:
- Received (Rx) unmapped cells
- Received (Rx) unmapped VPI
- Received (Rx) unmapped VCI




n/a not available

n/u not used

n/r not received

Scroll through parameter 
display

<Reset> Resets (zeros) the error 
counters: FEC, CRC, and HEC.

Continuation on 

next page
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7 Operation on an ADSL Access

.

Display the connection parameters in long 
form for both downstream (d) and 

upstream (u), see table on page 48.

Display the bit distribution, e.g. bits 
transported per carrier frequency (tone). 
y-axis: bits
x-axis: tones (channels) 
Based on the bit distribution, it is possible 
to detect line disturbances (e.g. through 

HDB3, HDSL, RF, DPBO etc.)

n/a not available

n/u not used

n/r not received

Scroll through parameter 
display

<Reset> Resets (zeros) the error 
counters: FEC, CRC, and HEC

<Statistic> Display the ATM statistics.

Reset the error counters (FEC, 
CRC and HEC).
CAUTION: Once showtime has 
been reached, the ARGUS will 
automatically reset the error 
counters.

The ARGUS will return to the 
previous display

<Continue> Open next graphic

Continuation on 

next page

see page 46
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7 Operation on an ADSL Access
Graphic functions:
The graphic functions like Zoom, Cursor 
and Setting of the x-axis allow detailed 

analysis of the graphs.

The magnifying glass is shown in the 
display on a white background. 
The Zoom function is not active in this 
graph.






If the magnifying glass is shown in the 
display on a dark background, zoom is 
active.



Exit menu without making 
changes.

Using these numeric keys the 

Zoom function can also be 
activated within a graph. 

The Cursor function is described 

on page 44.

A description of how to change 

the units shown on the x-axis 

from tone to frequency can be 

found on page 44.

All of the settings made for view-

ing this graph will also be applied 

to the next one opened. 

<Zoom(x)++> Enlarges the central section of 
the graph (100%)

<Zoom(x)--> Deactivates <Zoom(x)++> and 
ceases enlargement.

The cursor keys can be 
used to move horizontally 
through the zoomed area.

Continuation on 

next page
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7 Operation on an ADSL Access
The         is used to switch the softkey


assignment. The ARGUS will switch from 
x-axis zoom to y-axis zoom.


















If the magnifying glass is shown in the 
display on a dark background, zoom is 

active.





The Cursor function is used to precisely 
measure graphs.

<Zoom(y)++> Enlarges the central section of 
the graph (100%)

<Zoom(y)--> Deactivates <Zoom(y)++>  
and ceases the enlargement.


The cursor keys can be used to 
move vertically through the 
zoomed area.

Continuation on 
next page
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7 Operation on an ADSL Access

Once the Cursor function is started, a 
green Cursor line will be displayed in the 
middle of the graphic.



The value of the graph at the cursor's 
current position will be displayed below the 
graph as follows:


The menu item x-axis setting can be used 
to change the x-axis label from Tone to 
Frequency.

<Cursor> Using the Cursor softkey, it is 
possible to switch the cursor on 
or off as needed once it has 
been activated from the menu.

x:  256th Tone

y:  4 Bits

Using the cursor keys "left" 
and "right", the cursor can be 
moved to any point in a 
graph to measure it.
Briefly tapping the cursor key 
will move the Cursor one 
position further in the graph. 
The Cursor will move in ever 
larger steps if you press and 
hold the cursor key down.

Continuation on 

next page
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7 Operation on an ADSL Access
Possible selections:
























The Zoom and Cursor functions can also 
be used in combination. As an example, it 
is easier to measure a specific point in a 
graph with the Cursor function if you have 
first zoomed in on the area. The zoomed 
area will not necessarily be centered on 
the Cursor. The graphic functions are 
available for any graph.




Tone: Display the value of the 
x-axis as tones.

Frequency: Display the value of the 
x-axis as frequencies.

Set the x-axis directly

Using the cursor keys "left" 
and "right", you can scroll 
through the zoomed area (in 
this example, frequency).

Continuation on next 

page

Graphic functions
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Display of the signal-to-noise ratio (SNR) 
for each tone
y-axis: SNR in dB
x-axis: Tones (channels)

In this manner, it is possible to detect 
interference on individual tones 
(channels), in this example DPBO 
(Downstream Power Backoff).




Display the quiet level noise (QLN) for 
each tone. The QLN displays the quiet 
level noise of the wire pair as function of 
the frequency.
y-axis: QLN in dBm/Hz
x-axis: tones (channels)

Based on the QLN it is possible to detect 
narrow-band interference caused by, for 
example, a medium-wave radio station or 
a defective switching power supply. Such 
interference will appear as small peaks. 
The example shows a line with 
interference from a power supply.



Display of the amplitude component of the 
transfer function (HLOG) for each tone. 
The HLOG shows the attenuation of a line 
for each frequency.
y-axis: Hlog in dB
x-axis: Tones (channels)

<Menu> Opens the Graphic functions, 
see page 42).

<Menu> Opens the Graphic functions, 
see page 42).

Continuation on 

next page

Other result graphs
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7 Operation on an ADSL Access

If a line is in good condition, the values will 
fall as the frequency rises; for a very short 
line, they will be nearly horizontal. In this 
example, a short line is shown. The 
upstream and downstream values from 
the DSLAM and the downstream values 
calculated by the ARGUS may sometimes 
be skewed in the HLOG graphs. Other 
times the DSLAM may not send the 
upstream value of the HLOG or may even 
send one that is false.

DSL connections are often possible even 
though one of the two wire pairs is high 
impedance or even open (with just 
capacitive coupling). Such defective lines 
commonly cause frequent interruptions 
and/or loss of data. The following can 
cause such problems: oxidized access 
lines, bad contacts in the telephone 
wallsockets, loose terminal clamps or 
badly insulated lines. In such cases, the 
attenuation on the line is higher for low 
frequencies than it is for high frequencies. 
This can be recognized by the unusual 
relationship between the upstream and 
downstream attenuation or nature of the 
HLOG curve. Where the problem is 
caused by one of the wires, the 
attenuation is often lower for low 

frequencies than for higher frequencies.

The example at the side shows what is 
known as a drop. This may indicate a stub 
line (bridge tap).
Using the rule of thumb:
L[m] = 50 / f [MHz],
and knowing the frequency in MHz (in this 
example 0.535 MHz), it is possible to 
estimate the approximate length of the 
stub line:
L [m] = 50 / 0.535 MHz = 93 m 
There is a stub line of approximately 93 m 
in length.

<Menu> Opens the graphic functions 
(see page 42). 

<Continue> ARGUS will return to the 
Bits/tone graphs.

Example: Bridge tap

Example: skew + bad contact
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The ARGUS determines the following ADSL connection parameters:

ADSL connection parameters:

ATM The actual usable ATM bitrate in kbit/s.

Attainable ATM This is the theoretically attainable bitrate in kbit/s.

Relative capacity Utilization of the line as a percentage.

Latency mode Depending on the configuration of the DSLAM, the ARGUS will 

display either Interleaved or Fast.

Attenuation The line’s attenuation in dB over its entire length and 

bandwidth. Certain types of access are not suitable where the 

line attenuation is particularly high. When considering the 

attenuation values to determine the recommended access 

types, it is better to use the dB values in the Hlog graphs with a 

300 kHz cursor setting.

Output power Output power in dBm referenced to 1 mW.

SNR margin Signal-to-noise margin in dB The SNR margin is a measure of 

how much additional noise the transmission can withstand and 

still achieve a BER (Bit Error Rate) of 10-7. This value is the 

amount of reserve that a line has to deal with interference. 
Rule of thumb: The SNR margin downstream should be at least 

twice the SNR margin upstream or more.

Impulse noise prot. The Impulse Noise Protection (INP) is an indicator of the quality 

of the protective mechanism as far as impulse noise is 

concerned. The number of DMT symbols, which can be 

completely distorted in succession, without an error occurring 

on the higher layers.

Interleave delay This is the delay (in ms) caused by interleaving the data blocks.

FEC Forward Error Correction
The number of transmission errors corrected using the cell 

checkbytes.

f (far): Errors that the DSLAM has detected and informed 

the ARGUS.

n (near): Errors which were detected by the ARGUS in the 

blocks it received. 

CRC Cyclic Redundancy Check
The superframe checksum sent from the opposing end does 

not match the one calculated locally. Possible cause: Fault on 

the line.
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System information regarding the transmission to the remote end in ADSL 

Usually, when a modem synchronizes with a DSLAM, information on the 
manufacturer and type of modem will be sent to the DSLAM's control system. In 
the case of ADSL, this is performed in accordance with ITU-T G.997.1. If an 
ARGUS is synchronizing with a DSLAM, it will - depending on the DSLAM - send 
the following to the control system:

f (far): Errors that the DSLAM has detected and informed 

the ARGUS.

n (near): Errors which were detected by the ARGUS in the 

blocks it received.

HEC Header Error Checksum
The number of ATM cells with bad header checksums.

f (far): Errors that the DSLAM has detected and informed 
the ARGUS.

n (near): Errors which were detected by the ARGUS in the 
blocks it received.

Reset Shows how often the error counters have been reset by the 

user with the <Reset> softkey.

Resync: Number of times that the ARGUS has been resynchronized.

Vendor far: The manufacturer of the ATU-C-side, see page 217 for more 

information.

Version: Vendor Specific Information, generally shows the version of the 

software running at the ATU-C (DSLAM) end.

Vendor near: Manufacturer of the ARGUS chipset (ATU-R), see page 217 for 

more information.

Version: Vendor Specific Information, shows the software version of the 

ARGUS.

Info Displayed at the DSLAM Meaning

System Vendor ID 0x04, 0x00 (hex) Country Code: Germany

INGE or
0x49, 0x4E, 0x47, 0x45 (hex)

Provider Code:
intec Germany

0x20, 1x00 (hex) System-FW-Version: 2.10.0

Version Number R2.10.00 U_ Device-FW-Version: 2.10.0

Serial Number ARGUS1419999 Device Type:
ARGUS 141 / Device serial 
number 9999
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Clear down the ADSL connection and save the reports


ARGUS State Display









Clear down the ADSL connection.











The ARGUS saves the ADSL connection 
parameters together with the trace data 
in the first available memory location. The 
memory location can be given any name 
desired (see page 198).
Default setting: AMP_1, AMP_2....
If the memory is full, you must manually 
select a memory location to be 
overwritten.

<No> The results will be discarded.

<Yes> Save results

Continuation on 

next page

Save report
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Once the results have been successfully 
saved in memory, the ARGUS will return 
to the Status screen or ARGUS State 
Display.
A new sync attempt can be started by 
pressing <Start>.
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Displaying the saved test reports


ARGUS - Main Menu




Mark the saved test results.












Display the test results:
The ARGUS displays the ADSL state and 
the ADSL connection parameters.








Bit distribution display (Bits/tone)

<Date> Display of the date and time 
that the results were saved. 


Scroll through the ADSL connection 
parameters.

<Continue> Display of the signal-to-noise 
ratio for each tone (SNR / 
tone), the QLN / tone, the 
Hlog / tone and the trace 
data. 

Close the results display.

View

Test results
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7.4 The ARGUS in the ATU-R Bridge Access Mode

Connect the ARGUS to the ADSL access using the xDSL cable and to the PC with a patch 

cable.
In Bridge mode, the ARGUS acts like an ADSL modem, i.e. the ARGUS passively passes 

all packets from the Ethernet side to the ADSL access (and vice versa). In this case, the PC 

is responsible for setting up the connection.

Bridge/Router settings, see page 33.



Settings

Bridge/Router Ethernet Autonegotiation On / Off, see page 79.

IPv4 - IP mode:

- Local (own) IP address
- IP netmask
- DHCP server:

Static IP
DHCP server


Start / end address 
Domain
Reserve time

Patch cable
xDSL cable

LANLine jack

Ethernet ADSL 

  ADSL 
Access

PCProtocol, e.g. PPP
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Setting the access mode to ATU-R Bridge:


ARGUS - Main Menu



















The test is not yet started: 
red LED in display
Key to the LED symbolized in the display:

Display:



or

 and  




in the Status screen.

Red LED no test started

Yellow LED test started

Green LED A connection has been 
setup.

- Access mode

- Default (preset) profile, see page 30

- Current State

- Interface's DC voltage

Access

ADSL

Continuation on next 

page
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7 Operation on an ADSL Access
The test is not yet started!
The meaning of the arrow in the Layer 1 
box:


Display shows (Layer 1 box):



The ADSL connection has been setup 
(green check mark in the Layer 1 box).





The bridge can also be activated directly. If 
Layer 1 has not yet been setup, it will be 
setup automatically.



Switch to Layer 1 box and other elements, 
for details on the operation, see page 83.

grey arrow no test started

yellow arrow test started

green check 
mark

A connection has been 
setup.

- Access mode

- ADSL mode

- Current State

- Interface's DC voltage

<Edit> Setting the Bridge/Router 
parameters

<Stop> Deactivate Bridge mode.

<Info> This displays the Bridge mode 
activity.

When the active ADSL physical line is in 
Bridge mode, the following tests may 
started using the <Test> softkey, see 
page 104.

When Bridge mode is active no 
tests are available.

Display the connection 
parameters

Using the cursor 
keys, select Bridge 
(see page 83).

Set up an ADSL connection

Set up an ADSL Bridge
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<Info> 
or

Display the ADSL 
connection parameters, 
see page 39.

<Stop> Clear down the ADSL 
connection and automatically 
deactivate the bridge.
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7 Operation on an ADSL Access
7.5 The ARGUS in the ATU-R Router Access Mode

Connect the ARGUS to the ADSL access using the xDSL cable and to the PC with a patch 

cable.
In Router mode, the ARGUS replaces not only the modem but also the router. In this case, 

several PCs (connected via a hub/switch) can access the connection via a network 

connection. The network IP addresses can either be assigned statically or the ARGUS can 

serve as a DHCP server and assign IP addresses to the connected PCs.

Bridge/Router settings, see page 33:.


ADSL settings, see page 32:



Settings

Bridge/Router Ethernet Autonegotiation On / Off, see page 79.

IPv4 - IP mode:

- Local (own) IP address
- IP netmask
- DHCP server:

Static IP
DHCP server


Start / end address 
Domain
Reserve time

Router - NAT On / Off
- SIP port

Setting

Access parameters Phys. 
parameters

ADSL ADSL mode
Annex B firmware
Rated value
INP/SNRM

Ethernet 

ADSL 

Ethernet 

Hub/Switch

Ethernet 

 ADSL 
Access


The ARGUS does not have 
a firewall!

PC 

PC 

e.g. PPP IP
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7 Operation on an ADSL Access
Setting the access mode of the ATU-R Router:


ARGUS - Main Menu






The test is not yet started: 
red LED in display
Key to the LED symbolized in the display:

Display:



The test is not yet started:

The meaning of the arrow in the Layer 1 
box:

Display shows (Layer 1 box):

or

 and  




in the Status screen.

Red LED no test started

Yellow LED test started

Green LED A connection has been 
setup.

- Access mode

- Default Profile (Profile 1)

- Current State

- Interface's DC voltage

grey arrow no test started

yellow arrow test started

green check 
mark

A connection has been 
setup.

- Access mode

- ADSL mode

- Current State

- Interface's DC voltage

<Profile> Open profile see page 36

Access

ADSL

ATU-R Router

Using the cursor keys 
select the Virtual Line and 
then use the softkey to 
open the Router display, 
see page 83.
Setting up an ADSL connection
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7 Operation on an ADSL Access

 

.




Virtual Line selected






Router selected

The router can also be activated directly. If 
Layer 1 has not yet been setup, it will be 
setup automatically.


When the active ADSL physical line is in 
Router mode, the following tests may started
using the <Test> softkey, see page 104.

When Router mode is active, no 
tests are available from the Router

<Edit> For details on setting the 
parameters, see chapter 10 
Virtual Lines (VL) page 82.

<Edit> For details on setting the 
Bridge/Router parameters, see 
page 33.

Setup the ADSL Router.
The ADSL connection is active.

Displays and operation like those in 
Bridge mode, see page 55.

Use the cursor keys to 
select Router, see 
page 83.
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8 Operation on a VDSL Access
8 Operation on a VDSL Access

The ARGUS supports the following types of access (access modes): 

The individual VDSL tests record and store data (e.g. when tracing, IP data). The 

user must comply with the statutory regulations governing the collection and 

storage of such data and his obligation to give notice in this connection.

The voltages on the subscriber line may not exceed 200 VDC and should be free 

of AC voltage.

The ARGUS operating temperature can be affected by a high data throughput 

using the VDSL interface. Operating the ARGUS permanently at its performance 

limit can cause the activation of the temperature-induced protective mechanism, 

described in the chapter safety instructions.

8.1 Setting the VDSL Interface and Access Mode

The VDSL interface and Access mode are configured in the same manner as an ADSL 

access, see page 28 et seq.

Note: Starting functions with the numeric keys / key combinations
The ARGUS keypad can be used to call up or start the main functions and/or tests directly. 

An overview of the possible key combinations can be found on page 104.

VTU-R Terminal mode (VDSL Transceiver Unit Remote), see page 62.
Connection of the ARGUS directly to the VDSL access (before or 

after the splitter). The ARGUS replaces both the modem and the PC.

VTU-R Bridge Bridge mode (VDSL Transceiver Unit Remote Bridge), see page 70.
Insertion of the ARGUS between the VDSL access and the PC. The 

ARGUS replaces the VDSL modem.

VTU-R Router Router mode (VDSL Transceiver Unit Remote Router), see page 73.
Insertion of the ARGUS between the VDSL access and the PC. The 

ARGUS replaces both the VDSL modem and the router.
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8 Operation on a VDSL Access
8.2 VDSL Settings

The VDSL settings are configured in the same manner as those for an ADSL access, see 
page 29 et seq..

Rated value

FW

Carrier Set

The MAC address and the access parameters for the Bridge/Router can be found in the 
chapter on ADSL, see page 33. For more on all other access parameters, see chapter 10 
Virtual Lines (VL) page 82.

Setting Explanation

Access parameters:

Phys. parameters:

VDSL: Access parameters for the VDSL connection

Use the keypad to enter the upstream and downstream comparison 

values for the bitrate in kbit/s. 
If the current bitrates on the VDSL connection exceed the rated 

values, the ARGUS status will show "OK“, otherwise "FAIL“ will be 

displayed.Default setting: d: 0 and u: 0

Selection of the firmware (FW) in the VDSL chipset.
The available firmware options are Feature Sets FS10.3 and 

FS10.4.
For more information, please contact us.
Default setting: FS10.3

The Carrier Set sets the carrier frequencies that the ARGUS will 

use to signal the DSLAM that it is ready for synchronisation 
(ITU G.997.1). 
Normally, the network operator specifies which set should be used. 
The following sets with the associated upstream tones (the interval 

between the tones is 4.3125 kHz) can be selected on the ARGUS: 

- A43, Tones: 9, 17, 25 
- B43, Tones: 37, 45, 53 
- V43, Tones: 944, 972, 999 
Default setting: A43,B43, V43
When multiple sets are selected, the ARGUS will cyclically send 

the tones of the selected sets in parallel.
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8 Operation on a VDSL Access
Especially in VTU-R Bridge mode, ARGUS is able to support a special VLAN handling, see 

table below:

Bridge:

VLAN 
handling

VLAN ID

8.3 The ARGUS in the VTU-R Access Mode

Determining the VDSL connection parameters
The ARGUS is connected directly to the VDSL access (either before or after the splitter) 

using the included xDSL cable or a patch cable. In this case, the ARGUS replaces both the 

modem and the PC. The ARGUS will set up a VDSL connection and determine all of the 

relevant VDSL connection parameters. The ARGUS displays the VDSL connection 

parameters and saves them after the connection is cleared down if desired.


Use only the cable included in the package!





Setting the VTU-R access mode:

The VTU-R access mode settings are configured in the same manner as those for ATU-R, 

see page 35.

If the VLAN method "tagging" is used, a VLAN tag will be added to 

the outgoing Ethernet frames (sent to the WAN-side) while VLAN 

tags will be removed from incoming Ethernet frames. When the 

bridge is "Transparent", the Ethernet frames will be passed on 

unchanged.
Defaul setting: Transparent

Identifier for the VLAN to which the frame belongs. Every VLAN is 

assigned a unique number, the VLAN ID. A device, which belongs 

to the VLAN with the ID = 1, can communicate with every other 

device in the same VLAN, but not with a device in other VLANs (i.e. 

one with a different ID such as 2).
Range: from 0 to 4095
Default setting: 0

Line 

jack
VDSL access
VTU-C (DSLAM)

xDSL cable or patch cable
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8 Operation on a VDSL Access
Continuation on 

next page

or

Setting up a VDSL connection

Profile settings:

When setting up the VDSL connection, the ARGUS uses the settings saved in the profile 

(see page 61).

ARGUS - Status screen.

The ARGUS will use the default (preset) 

profile to setup the VDSL connection (in 

this example, Profile 1).


<Edit>

<Profile>

Setting up a VDSL connection

The ARGUS synchronizes with the 
DSLAM (the “Sync / L1” LED will flash and 
an element with a yellow background will 
be shown in the display).
The ARGUS will display the current 
connection status (in this example 
"Initialize") in the Layer 1 box (blue).






While setting up the connection:
Display:

Open the access parameters, 
see page 61.

Profile settings are like those 
for ADSL, see page 30.

- Current connection status

- Time elapsed since the start of 
synchronisation in h:min:sec.
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8 Operation on a VDSL Access
Command symbols:


Display timestamp.



The ARGUS shows the time when 
(ARGUS internal clock, see page 203) the 
command arrived.


< = command sent from the ARGUS

> = command sent from the DSLAM

- = connection status

Switch back to the previous 
display and the Status screen.
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8 Operation on a VDSL Access
Connection successfully setup

As soon as the connection has been setup ("Sync/L1" on constantly and a green check 

mark in the Layer 1 box), the ARGUS will determine the VDSL connection parameters. 

After the ARGUS has synchronized, please leave it connected to the VDSL access for at 

least another 20 seconds since the VDSL connection parameters supplied by the DSLAM 

cannot be stored in the ARGUS until this period of time has elapsed.

ARGUS - Status screen

Display shows (Layer 1 box):


If the current data rate exceeds the rated 
value set (see page 61), the ARGUS will 
display a green "OK" in the ARGUS status 
(see page 28) otherwise it will show a red 
"FAIL".


- Access and Access mode

- VDSL Profile assigned by the 
DSLAM. The VDSL2 standard 
supports eight different "Profiles". 
Among other things these profiles 
specify the respective cutoff 
frequency, the interval between 
carrier frequencies as well as the 
signal strength generated. As a 
result of these definitions, it is 
possible that the maximum data rate 
attainable will vary from profile to 
another (in example, "17a").

- d: Downstream data rate
u: Upstream data rate

- Number of CRC errors in
downstream and upstream data

- Interface's DC voltage

<Info> Display the VDSL connection 
parameters.

<Stop> Clear down the VDSL 
connection.

Continuation on 

next page

or
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8 Operation on a VDSL Access

Display of the VDSL connection 
parameters in brief:
- d/n: downstream/near 
- u/f: upstream/far


Display the connection parameters in long 
form for both downstream (d) and 

upstream (u), see table on page 68.


Scroll through the 
connection parameters.

<Trace> Display the trace data, see 
page 63.

<Graph> Display the graphs, see 
page 67.

n/a not available

n/u not used 

n/r not received


Scroll through the parameters

<Statistic> Open the Ethernet statistics, 
see page 81

Reset (zero) the FEC and 
CRC error counters

Reset the error counters (FEC 
and CRC).
CAUTION: Once showtime has 
been reached, the ARGUS will 
automatically reset the error 
counters.

Continuation on 

next page
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8 Operation on a VDSL Access
Display of the bit distribution i.e. 
transported bits per tone (channel).
The bands for upstream and downstream 
change depending on the VDSL profile 
(green: upstream, blue: down-stream, in 
this example, US0, DS1, US1, DS2, US2, 
DS3) 
y-axis: bits
x-axis: tones (channels) 
Based on the bit distribution, it is possible 
to detect line disturbances (e.g. through 
HDB3, HDSL, RF etc.)









Graphic functions:
The graphic functions like Zoom, Cursor and Setting of the x-axis allow detailed analysis of 
the graphs. These, as well as other result graphs (e.g. SNR/tone, QLN/tone and HLOG/
tone) can be opened and used in the same manner as with ADSL (see page 42 et seq.).

The ARGUS will return to 
the previous display

<Continue> Scroll to the next graphic
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8 Operation on a VDSL Access
The ARGUS determines the following VDSL connection parameters:

VDSL connection parameters:

Actual bitrate The actual usable bitrate in kbit/s.

Attainable bitrate This is the theoretically attainable bitrate in kbit/s.

Relative capacity Utilization of the line as a percentage.

SNR margin SIgnal-to-noise ratio in dB in the bands used.The SNR margin 

is a measure of how much additional noise the transmission 

can withstand and still achieve a BER (Bit Error Rate) of 10-7. 

This value is the amount of reserve that a line has to deal with 

interference.
Unused bands are marked as n/u (not used).

Loop attenuation The line’s attenuation in dB over its entire length and 

bandwidth. Certain types of access are not suitable where the 

line attenuation is particularly high. When considering the 

attenuation values to determine the recommended access 

types it is better to use the dB values in the Hlog graphs at a 
1 MHz cursor setting.
Unused bands are marked as n/u (not used).

Signal attenuation Signal attenuation in dB in the relevant bands.
Unused bands are marked as n/u (not used).

Output power Output power in dBm referenced to 1 mW.

Interleave delay This is the delay (in ms) caused by interleaving the data blocks.

Impulse noise prot. The Impulse Noise Protection (INP) is an indicator of the quality 

of the protective mechanism as far as impulse noise is 

concerned. The number of DMT symbols, which can be 

completely distorted in succession, without an error occurring 

on the higher layers.

FEC Forward Error Correction

The number of transmission errors corrected using the cell 

checkbytes.

f (far): Errors that the DSLAM has detected and informed 

the ARGUS.

n (near): Errors which were detected by the ARGUS in the 

blocks it received. 
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8 Operation on a VDSL Access

System information regarding the transmission to the remote end is VDSL. 

If the ARGUS is on a VDSL access and is synchronized with a DSLAM in accor-
dance with ITU-T G.997.1, it will register with the DSLAM's control system. The 
data in the DSLAM will be displayed as it is for ADSL, see page 49.

Clear down the VDSL connection and save the results
The process of clearing down a VDSL connection and saving the results is performed in the 

same manner as in the case of an ADSL connection, see page 50.

Displaying the saved test reports
The saved VDSL test results are displayed in the same manner as those for an ADSL 
access, see page 52.

CRC Cyclic Redundancy Check


The superframe checksum sent from the opposing end does 

not match the one calculated locally. 
Possible cause: Fault on the line.

f (far): Errors that the DSLAM has detected and informed 

the ARGUS.

n (near): Errors which were detected by the ARGUS in the 

blocks it received. 

Reset Shows how often the error counters have been reset by the 

user with the <Reset> softkey.

Resync: Number of times that the ARGUS has been resynchronized.

Showtime no sync: Shows how often the connection has reached the status 

"Showtime" without establishing a permanent, stable 

connection.

Elec.length@1MHz Displays the electrical length at a frequency of 1 MHz in dB.
R: VTU-R-side 
C: VTU-C-side

Vendor far: The manufacturer of the VTU-C-side, see page 217 for more 

information.

Version: Vendor Specific Information, generally shows the version of the 

software running at the VTU-C (DSLAM) end.

Vendor near: Manufacturer of the ARGUS chipset (VTU-R), see page 217 for 

more information.

Version: Vendor Specific Information, shows the software version of the 

ARGUS.
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8.4 The ARGUS in the VTU-R Bridge Access Mode

Connect the ARGUS to the VDSL access using the xDSL cable and to the PC with a patch 
cable. In Bridge mode, the ARGUS acts like an VDSL modem, i.e. the ARGUS passively 
passes all packets from the Ethernet side to the VDSL access (and vice versa). In this 
case, the PC is responsible for setting up the connection.

Patch cable
xDSL cable

LANLine jack

Ethernet VDSL 

  VDSL 

access

PCProtocol, e.g. PPP



Bridge/Router settings, see page 33

Setting the access mode to VTU-R Bridge:

Access

VDSL

ARGUS - Main Menu














Continuation on next page

Setting

Bridge/Router Ethernet Autonegotiation On / Off, see page 79.

IPv4 - IP mode:

- Local (own) IP address
- IP netmask
- DHCP server:

Static IP
DHCP server 


Start / end address 
Domain
Reserve time

or

 and  




in the Status screen.
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The test is not yet started: 
red LED in the display
Key to the LED symbolized in the display:

Display:

The test is not yet started!

The meaning of the arrow in the Layer 1 

box:

Display shows (Layer 1 box):



The VDSL connection has been setup 

(green check mark in the Layer 1 box).





Continuation on next page.

Red LED no test started

Yellow LED test started

Green LED A connection has been 
setup

- Access mode

- Default (preset) profile, see page 30

- Current State

- Interface's DC voltage

grey arrow no test started

yellow arrow test started

green check 
mark

A connection has been 
setup

- Access

- Access mode

- Current State

- Interface's DC voltage

<Edit> Setting the Bridge/Router 
parameters.

Using the cursor keys, 
select Bridge, see 
page 83.

Setting up a VDSL connection

Setting up a VDSL Bridge
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8 Operation on a VDSL Access
The bridge can also be activated directly. If 
Layer 1 has not yet been setup, it will be 
setup automatically.









Switch to Layer 1 box and other elements, 
for details on the operation, see page 82.



<Stop> Deactivate Bridge mode.

<Info> This displays the Bridge mode 
activity.

Display the connection 
parameters.

<Info> 
 or 

Display the VDSL 
connection parameters, 
see page 66.

<Stop> Clear down the VDSL 
connection and automatically 
deactivate the bridge.
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8.5 The ARGUS in the VTU-R Router Access Mode

Connect the ARGUS to the VDSL access using the xDSL cable and to the PC with a patch 

cable. In Router mode, the ARGUS replaces not only the modem but also the router. In this 

case, several PCs (connected via a hub/switch) can access the connection via a network 

connection. The network IP addresses can either be assigned statically or the ARGUS can 

serve as a DHCP server and assign IP addresses to the connected PCs.

Bridge/Router settings, see page 33.


VDSL settings, see page 61:



Setting

Bridge/Router Ethernet Autonegotiation On / Off, see page 79.

IPv4 - IP mode:

- Local (own) IP address
- IP netmask
- DHCP server:

Static IP
DHCP server


Start / end address 
Domain
Reserve time

Router - NAT On / Off
- SIP port

Setting

Access parameters Phys. 
parameters

VDSL Rated value
FW (Firmware)
Carrier set

Ethernet 

VDSL 

Ethernet 

Hub/Switch

Ethernet 

  VDSL 

access


The ARGUS does not have 
a firewall!

PC 

PC 

e.g. PPP IP
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Setting the access mode to VTU-R Router:


ARGUS - Main Menu






The test is not yet started: 
red LED in display
Key to the LED symbolized in the display:

Display:


The test is not yet started:

The meaning of the arrow in the Layer 1 
box:

Display shows (Layer 1 box):

or

 and  




in Status screen.

Red LED no test started

Yellow LED test started

Green LED A connection has been 
setup

- Access mode

- Default Profile (Profile 1)

- Current State

- Interface's DC voltage

grey arrow no test started

yellow arrow test started

green check 
mark

A connection has been setup

- Access mode

- Current State

- Interface's DC voltage

<Profile> Open profile see page 36

Access

VDSL

VTU-R Router

Use the cursor keys to 
select Router, see page 
83.

Setting up a VDSL connection
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8 Operation on a VDSL Access

Router selected.

The router can also be activated directly. If 
Layer 1 has not yet been setup, it will be 

setup automatically.
<Edit> Setting the Bridge/Router 

parameters, see page 33.

Setup the VDSL Router.
The VDSL connection is active!

Displays and operation like in Bridge 
mode, see page 71.
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9 Operation on an Ethernet Access
9 Operation on an Ethernet Access

In Ethernet mode, the ARGUS supports the following types of access: 

The individual tests record and store data. The user must comply with the 
statutory regulations governing the collection and storage of such data and his 
obligation to give notice in this connection.

 

Patch cable

LAN

Ethernet e.g. xDSL 

Connection to a Modem:

Modem

e.g. an xDSL 

access





LAN

Ethernet e.g. xDSL 

Connection to a Router/Modem:

Router/ModemPatch cable

e.g. an xDSL
access

LAN

Ethernet e.g. xDSL 

Connection to a PPTP Router/Modem:

PPTP Router/ModemPatch cable

 e.g. an 

xDSL access
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9 Operation on an Ethernet Access







9.1 Setting the Ethernet Interface

The Ethernet interface settings are made in the same manner as they are for an ADSL 

access, see page 28.

Note: Starting functions with the numeric keys / key combinations
The ARGUS keypad can be used to call up or start the main functions and/or tests directly. 

An overview of the possible key combinations can be found on page 104.

Settings in the profile:

Access parameters

Ethernet Autonegotiation On / Off

LAN

Ethernet 

Connection to a PC via IP

PC
Patch cable

LAN

Connection to an IP network

Ethernet 

Hub/Switch

Patch cable PC

PC
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9.2 Ethernet Settings
The Ethernet settings are changed in the same way as those for an ADSL access, 
s. page 29.

Autonego-
tiation



For information on other access parameters, see chapter 10 Virtual Lines (VL) page 82.

Setting Explanation

Access parameters:

Phys. parameters:

Ethernet:

Switch on or off
If autonegotiation is enabled, a network card can independently determine 

the correct transmission speed and duplex setting for the network port to 

which it is connected and can then configure itself accordingly. In the case of 

Ethernet, auto-negotiation is based on Layer 1 of the OSI Model (in 

accordance with the IEEE 802.3u standard). 
Default setting: on
For information on the off setting, see the next section page 79.

MAC address:

Display and selection of the MAC addresses. 
The first two MAC addresses cannot be changed manually.

1. If the default MAC address is selected, the ARGUS will use its own MAC 

address. 

    Default setting: Default MAC address

2. If Dynamic MAC Address is selected, a different MAC address will be 

used for each synchronization.

3. A third MAC address can be entered: Mark a line and then press <Edit>. 

<Edit> Edit the MAC address for the entry.
Enter the address in hexadecimal from the keypad and the 

softkeys <A..F> (e.g. to enter a “C” press the softkey three 

times or for an “F” six times; conclude by pressing <OK> to 

confirm your entry). Group MAC addresses cannot be 

used.
Default setting: 00:00:00:00:00:00

Use the address.
The new address is only saved temporarily and will not be 

available when the ARGUS is switched on again.

One after the 

other 

 and

Displays the ARGUS MAC addresses:
Line, LAN, see also page 106 f.
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9 Operation on an Ethernet Access
Autonegotiation / Ethernet Link Parameter

The default setting supports "autonegotiation" for the Ethernet link.

Setting: Autonegotiation "on"

When negotiating the link parameter, the ARGUS notifies the remote end that the following 
are supported (these settings are fixed; they cannot be reconfigured):
- 10 or 100 Mbit/s, Default setting: 100 Mbit/s
- half or full-duplex
- Flow control on / off (when on: sym. and asym. pause) 

Manual setting of the Ethernet link parameter

Setting: Autonegotiation "off"

When "autonegotiation" is deactivated, the speed, duplex mode, flow control (flow control = 
"Pause" mode) are set in the profile (see page 78). 
- 10 or 100 Mbit/s, Default setting: 100 Mbit/s
- half or full duplex, Default setting: Full
- Flow control on / off (flow control is only reasonable when operating in full duplex)

Default setting: on

One-sided Autonegotiation 

If a device which has autonegotiation enabled (on) attempts to connect to a 
device on which autonegotiation is disabled (off) or not supported, no information 

will be exchanged with the remote end. The speed will still be determined even without 
autonegotiation by listening for NLP signals (10Base-T) or a 100Base-TX idle pattern 
(parallel detection). In this case, the device using autonegotiation will generally fall back to 
half duplex (duplex mismatch is possible). This may lead to a conflict between the duplex 
modes with "poorer" performance.
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9 Operation on an Ethernet Access

:

p

 

9.3 Setup an Ethernet connection

Setup an Ethernet connection

Continuation on 

next page

or

ARGUS - Status screen

The ARGUS will use the default (preset) 
profile to setup the Ethernet connection 
(in this example, Profile 1).

The meaning of the arrow in the Layer 1 box

grey arrow

yellow arrow

green check 
mark

The test is not yet started!

no test started

test started

A connection has been setu

<Info> Displays the Ethernet 
connection parameters

<Test> Display the tests possible, see
page 104

<Start> Activate Ethernet

<Stop> Disable the Ethernet 
connection







Display:

- Autonegotiation setting 

- Autonegotiation on the remote end 

- Negotiated speed 

- Type of duplex mode 

- Flow control setting

<Statistic> Open Ethernet statistics
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9 Operation on an Ethernet Access
Statistics display:

Clear down the Ethernet connection and save the results
The process of clearing down an Ethernet connection and saving the results is performed 
in the same manner as in the case of an ADSL connection, see page 50.

- Ethernet frames received (Rx) and 
sent (Tx)

- Bytes received (Rx) and sent (Tx)

- Number of errors on the receiving 
(Rx) and sending (Tx) sides

- Number of collisions
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10 Virtual Lines (VL)

Virtual Lines (VL) are used to gather the settings for Layer 2 and Layer 3 into a profile - a 
VL profile. These profiles can hold information about, for example, the protocols, VPI/VCIs, 
VLANs and PPP data (in their own subordinate PPP profiles). With the aid of Virtual Lines, 
it is possible to perform tests on multiple VPI/VCIs or VLANs and various protocols. 
Up to 10 Virtual Line profiles can be saved in the ARGUS. The settings in a VL profile, for 
example, the protocol setting, can be edited. Regardless of the state of the physical layer 
(Layer 1), the VL profile can be assigned to one or more services. 
Therefore, it is possible to run a data test (such as an IP ping test) and a VoIP test (like a 
VoIP call) on the active access without having to setup Layer 1 (DSL, Eth) again - in spite of 
the fact that the protocols are different.

10.1 Virtual Lines in the Status screen

Virtual Lines in the Status screen are explained below using an ATU-R Router ADSL 
access as an example:

Services,
see page 102

Layer 1

Router/Bridge 
(xTU-R Bridge and 
xTU-R Router only)

Virtual Lines

Profile name

Current assign-
ment of the soft-
keys, see page 
106

Virtual Line for 
Bridge/Router, 
settings, see 
page 33
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The Status screen is organized in three levels, which can be accessed individually using 
the ARGUS cursor keys.
The Status screen will described in greater detail using three displays as examples.

Cursor at 
top

Cursor at 
top

<Edit>

<Profile>

<Start>

Layer 1: Physical Layer (see page 26)








Layer 2: Virtual Lines
The following configuration options are 
displayed:
 - Protocol (IP, PPP, PPTP)
 - ATM, see page 93
 - VLAN, see page 94
 - PPP (PPP profile)
 - PPTP, see page 95
 - IP version (IPv4, IPv6, Dual)
 - IPv4, see page 95
 - Data log (for this VL)

 - Profile name, see page 97

<Edit>

<Profile>



 Layer 3: Services (see page 102)

<Edit>

<Profile>

<Start>



Press the <Start> softkey to start both 
the Virtual Line and the physical layer.

Physical layer - configuration

Configure profile

Setup the physical layer for 
the selected access.

Virtual Line - configuration, 
see page 87

Configure profile

Assign a service to the VL 
and configure it

Configure profile

Start service
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Depending on the status of the physical layer, the Virtual Line or the service, the ARGUS 
displays different symbols in the graphic boxes.


There is still no Virtual Line assigned to this service.

This service, Virtual Line or physical layer is idle.

This service is not available (Bridge mode only).

Preparing to activate the physical layer, the Virtual Line or the service.

The physical layer, Virtual Line or service is currently being activated.

The physical layer, Virtual Line or service is being deactivated due to an unexpected 
event.

The deactivation is being performed.

The access has been successfully synchronized (physical layer) or a Virtual Line or 
service has been successfully activated without errors.

A test is currently running in this service.

An error has occurred here. To continue with this Virtual Line and service, press 
<Reset>. 

10.2 Virtual Line Profile (VL Profile)
Explanations of the various types of profile:

Profile (1 - 10), see page 30:

-

-

-

Virtual Line profile (Virtual Lines 1 - 10)

-

-

-

-

PPP profile (1 - 10)

-

-

-

Under the access parameters, you will find the Layer 1 settings (Phys. parameters, 
MAC address) and the assignments for the Data, VoIP, IPTV and VoD services.

In addition to the access parameters, these profiles also hold the settings for the 
Bridge/Router and the test parameters.

Each profile can be assigned an individual profile name.

These hold the settings for Layers 2 and 3.

Virtual Line profiles are assigned to services.

Each Virtual Line can be assigned to multiple services.

PPP profiles can be assigned to the Virtual Line profiles.

These profiles hold all the data relevant for dialling.

PPP profile are assigned to the Virtual Line profiles.

Each PPP profile can be assigned to multiple Virtual Line profiles.
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ile 1

rofile 10
The relationship between the types of profiles
After all of the settings have been reset (see page 207), profiles (1-10) each have only one 
Virtual Line profile (1-10) that is assigned to the Data service. Each Virtual Line profile (1-
10) is assigned a PPP profile.
In this default state, none of the other services (VoIP, IPTV or VoD) are assigned a Virtual 
Line profile or PPP profile. 
The assignment of other Virtual Line profiles and PPP profiles to services will be described 
beginning on page 87.

Default configuration:

Profile 1

Data service => VL profile 1 => PPP Prof

VoIP service ... ...

IPTV service ... ...

VoD service .... ...







Profile 10

Data service => VL Profile 10 => PPP P

VoIP service ... ...

IPTV service ... ...

VoD service .... ...
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10.3 Virtual Line Activation
In order to activate a Virtual Line, a service or test must first be started. In order to start a 
test, a service must first be configured and assigned a Virtual Line. In this example, the 
Data service has been configured and assigned a Virtual Line.

10.3.1 Starting a service

Continuation on 

next page

The ADSL connection is active.













<Start>



Now the physical layer (ADSL), the Virtual 
Line, and the Data service are all active. 
This is indicated by the green "check 
marks".

<Info>

<Stop>



For an explanation of the services, see 
page 102.



Using the cursor keys, move from the 
Layer 1 box over the Virtual Line to 
the "Data" service.

If the physical layer is not yet 
active, it will be started 
automatically when the service or 
test is started.

Start service

The Data service 
information will be displayed 
(e.g. the duration of the 
activity).

The Data service will be 
stopped.
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The tests that can be run on the "Data" 
service will be displayed.

<Config>

10.3.2 Assigning additional Virtual Lines

The ARGUS can use multiple services (e.g. Data and VoIP) with a single Virtual Line. In 
this example, ADSL is active. The Data service has been selected. In the following, we will 
explain how multiple services can be connected using a single Virtual Line.

Continuation on next page












<Edit>

Configure the settings of the 
respective test (in this 
example, IP ping).
For more details, see the 
chapter on Tests (page 120). 

In order to configure a Virtual 
Line (which is connected the 
Data service in this example) for 
use with other services, its 
current service must first be 
stopped.
The physical layer remains 
active.


Use the cursor keys to 
select the VoIP service.

The settings for the selected 
service (in this example, VoIP) 
will open.
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Continuation on 

next page

Select "Virtual Line".











Since the VoIP service has not yet been 
assigned a Virtual Line profile, the list is 
first empty.

<Add>








<Edit>



Select the Virtual Line profile for the 
service.

Open the Virtual Line 
selection.

Select a Virtual Line profile 
for editing. The selected 
profile will be marked blue in 
the display. 

Elements that are not available 
will be grayed out.
For example, when they are 
currently active.

The possible settings are 
described on page 93 et seq.
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Continuation on 

next page


The selected Virtual Line profile will be 

displayed.

<Delete>

<Change>

<Edit>








The possible settings are described on 
page 93 et seq.

Open the PPP profile list





Up to ten PPP profiles can be configured.

<Edit>

The selected Virtual Line will 
be deleted.

The selected Virtual Line will 
be changed.

The selected Virtual Line will 
be opened for editing, see 
page 93.

Assigning the Virtual Line 
profile to the service, see 
page 91.


e.g. select PPP


e.g. select PPP profile 1

Open the selected PPP profile 
for editing, see page 93.
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Continuation on 

next page

3x




The possible settings are described on 
page 93 et seq.

<Delete>

<Change>










The ARGUS will open either the Status 
screen or the Settings menu (depending 
on whether the profile was opened from 
the Main Menu or the Status screen).

Return the previous menu and to 
selection of the Virtual Line profile.





After confirming your selection,
the selected profile must be 
confirmed once more.


The selected Virtual Line 
profile will be deleted.

The selected Virtual Line 
profile will be changed.

The ARGUS will use the 
selected profile.
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Select "Data" with the 
cursor keys and press 
<Start> to activate the 
service.



The "Data" and "VoIP" services are now 
connected to the physical layer (ADSL 
access) by single Virtual Line.





<Start>





The "VoIP" service is now active. 
It is now possible to perform various tests 
on the VoIP service.







In the next step, it is possible to activate 
another service.








The "Data" and "VoIP" services are active. 
It is now possible to perform various tests 
on both the "Data" and the "VoIP" 
services.









The displays and operation of IPTV and VoD (Video on Demand) services are like those 
of VoIP.

Start VoIP service
ARGUS 141 91



10 Virtual Lines (VL)
Other examples of different Virtual Line assignments:

Example 1:

Example 2:

Example 3:




One Virtual Line is connected to the Data 
service and another to the VoIP service.
The Virtual Line for VoIP can use different 
protocol data from that of the Virtual Line 
for Data.









A Virtual Line was configured for the Data, 
VoIP, IPTV and VoD services. 
In this example, the IPTV and VoD 
services are active.







In this example, each service has been 
assigned a Virtual Line. 
Since the ARGUS is in Bridge mode, 
these services cannot be performed.





In the case of the IPTV service it 
is possible to setup up to four 
Virtual Lines.
The ARGUS will however display 
these together as a single Virtual 
Line.
For more details, see the chapter 
on IPTV (page 173).
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10.4 Virtual Line Settings

Setting Explanation

Virtual Profile 1 to 10

Protocol Selection of the transfer protocol that the ARGUS should use for 

the test (e.g. for an IP test).
Default setting: PPP











The settings - regardless of whether the "ATM with Ethernet" or "ATM without Ethernet" 

protocol is used - will be handled under the heading ATM.

ATM: Settings for Asynchronous Transfer Mode

VPI/VCI VPI:
VCI:

Enter Virtual Path Identifier
Enter Virtual Channel Identifier
Range: VPI: 0 to 127, VCI: 32 to 255
Default setting: VPI: 1 and VCI: 32

Encapsulation Selection of the encapsulation of the packets to be sent: LLC or 

VC-MUX.
Default setting: LLC

Ethernet Sets whether Ethernet over ATM will be used or not, see table 

above.
Default setting: Yes









Protocol ATM: Interfaces:

ATM with ETH ADSL VDSL ETH

IP Yes EoA
IP

IP No IPoA

PPP Yes PPPoE
PPPoE

PPP No PPPoA

PPTP    -    -    - PPTP
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VLAN: VLAN (Virtual Local Area Network)

VLAN
 

Use VLAN: Specifies whether or not VLAN should be used:
Default setting: No

ID: Identifier for the VLAN to which the frame 

belongs. Every VLAN is assigned a unique 

number, the VLAN ID. A device, which belongs to 

the VLAN with the ID = 1, can communicate with 

every other device in the same VLAN, but not with 

a device in other VLANs (i.e. one with a different 

ID such as 2).
Range: from 0 to 4095
Default setting: 0

Priority: User - priority information:
An eight-level (3 bits) priority can be assigned to 

each frame. In this manner, it is possible e.g. to 

give priority to forwarding voice data (e.g. in the 

case of VoIP), while HTTP data will be handled as 

a lower priority.
Range: 0 to 7
Default setting: 0

PPP Profile: PPP settings (Point-to-Point-Protocol)
<Edit> Open PPP profile for editing

User name        

Entry of the user name assigned (by the 
network operator):

Use the keypad to enter the user name. 
When the right softkey is pressed it 
assumes a different meaning and thus 
influences the entries made from the 
keypad (uppercase or lowercase letters, 
or digits).


Password                                          Entry of the password assigned by the network operator, for more 

information, see User Name.
While entering the password the characters will remain visible until 

the password is confirmed. Afterwards, the characters of the 

password will be shown masked with "*".
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Set the IP If “Yes”, the IP address entered as IP / own IP address (see below) 

will be used for the connection.
Default setting: No

Activation 
delay

After setting up the PPP connection, the ARGUS will first wait until 

the period specified in the “activation delay” has elapsed before 

beginning a test.
Range: 2 to 10 seconds
Default setting: 2

Profile name Enter the name of the PPP profile

PPTP: PPTP settings (Point-to-Point-Tunneling Protocol)

Local server IP address
Range 0.0.0.0. to 255.255.255.255
Default setting: 0.0.0.0

IP version: Internet Protocol version

Setting that specifies which IP version should be used.

IPv4:

IPv6

Dual: 

Internet Protocol version 4, in accordance with 

RFC 791 
Internet Protocol version 6, in accordance with 

RFC 2460
If IPv6 is available, it will be used by default, if not 

the ARGUS will switch to IPv4.
Default setting: IPv4

IPv4: Internet Protocol version 4 - settings

IP mode Setting the assignment of the IP addresses 

Static IP:
DHCP client: 

DHCP server: 

DHCP auto: 

Static IP addresses
IP address assigned by the server (remote end)
IP address assigned by the ARGUS
ARGUS checks whether there is a DHCP server 

in the network. If yes, the IP address will be 

assigned by the server. Otherwise, the ARGUS 

will assign the address.
Default setting: DHCP Client 

Local 
IP Address

Own local IP address of the ARGUS
Range: 0.0.0.0 to 255.255.255.255
Default setting: 0.0.0.0 (see RFC 3330 regarding assignment)
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IP netmask IP netmask 
Range: 0.0.0.0 to 255.255.255.255
Default setting: 255.255.255.0 (see RFC 3330 regarding 

assignment) 

Gateway IP Gateway IP address
Range: 0.0.0.0 to 255.255.255.255
Default setting: 0.0.0.0 (see RFC 3330 regarding assignment)

DNS server DNS server 1 
DNS server 2
Entry of the DNS server's IP address
(DNS = Domain Name System)
Range: 0.0.0.0 to 255.255.255.255
Default setting: 0.0.0.0 (see RFC 3330 regarding assignment)

DHCP client DHCP Timeout (setting of how long to wait for the IP address):
Range: 1 to 9999 seconds
Default setting: 20 

DHCP Vendor ID:
- Format: Selection of the format: ASCII or hexadecimal
- ASCII data: Enter the DHCP Vendor ID in ASCII format
Default setting: ARGUS, for more information see "User name" on 

page 94
- HEX data: Enter the DHCP Vendor ID in hexadecimal format; for 
  more information see "MAC address" on page 78

DHCP Vendor Info:
- Format: Selection of the format: ASCII or hexadecimal
- ASCII data: Enter the DHCP Vendor Info in ASCII format
Default setting: ARGUS, for more information see "User name" on 

page 94
- HEX data: Enter the DHCP Vendor Info in hexadecimal 
 format; for more information see "MAC address" on page 78

DHCP User Class Information
- Format: Selection of the format: ASCII or hexadecimal
- ASCII data: Enter the DHCP User Class I. in ASCII format
 Default setting: ARGUS, for more information see "User name" on 

page 94
- HEX data: Enter the DHCP User Class Information in 
  hexadecimal format; for more information see "MAC address" on 
  page 78
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DHCP User-defined Option (creating a user-specific DHCP option)
- Option number
 Range: 0 to 255
 Default setting: 255 = off
- Format: Selection of the format: ASCII or hexadecimal
- ASCII data: Enter the DHCP Userdef. Option in ASCII format
 Default setting: ARGUS, for more information see "User name" on 

page 94
- HX data: Enter the DHCP User-defined Option in hexadecimal 

format, for more information see "MAC address" on page 78

DHCP server Options for the DHCP server:
- Start and End IP addresses
 Range: 0.0.0.0 to 255.255.255.255
 Default setting: (see RFC 3330 regarding assignment)
 Start: 192.168.10.30
 End: 192.168.10.40
- Name of the domain, for more information see "User name" on 
  page 94
- Reserve time of the IP addresses
  Range: 1 to 99999 hours
Default setting: 240

Data Log Data log on or off
This setting must be "ON“ in order to send a trace file to a PC see 

page 50. 
After a Virtual Line has been terminated by the associated service 

or the physical layer, the ARGUS will enquire whether the trace file 

should be sent to the PC. In order to send the trace file, the Trace/

remote (see page 202) function must be active and the ARGUS 

must be connected to a PC using the mini-USB.
As an example, if data Log is activated for Virtual Line 1, only 

Virtual Line 1 will be recorded. If a Virtual Line is configured for 

multiple services and data log is activated, all of this Virtual Line's 

data will be recorded.
Default setting: Off

Profile name Enter the name of the VL profile.
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10.5 Display the Protocol Statistics

Continuation on 

next page

Depending on the access mode and protocol, the ARGUS will display the BRAS, IP, PPP, 
ATM or Ethernet statistics.



The physical line, the Virtual Line and the 
Data service are active. 













BRAS information:
The ARGUS displays (for the PPP 
protocol only) the BRAS (Broadband 
Remote Access Server) information:
- AC (Access Server): Name of the server
- Service name: Name of the service

<Info> Display DSL events

<Stop> Deactivate physical layer, VL 
and data


Using the cursor keys switch to the 
Virtual Line.

One after the other 


 and

Displays the ARGUS 
MAC addresses:
Line, LAN, see also 
page 106 f.

<IPv4> Display the configuration 
assigned by the server.
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PPP information:
The ARGUS will display the number of 
PPP packets and bytes received (Rx) and 
sent (Tx).












Ethernet:
The ARGUS will display the number of 
Ethernet frames received (Rx) and sent 
(Tx) and the number of bytes and errors.








Display commands







<PPP> The <PPP> softkey is used to open 
a PPP trace in which the sequence 
of PPP messages will be shown.

< = command sent from the ARGUS

> = command sent from the DSLAM

<Time> The <Time> is used to tag 
(timestamp) the individual 
messages with times from the 
ARGUS system clock.

Continuation on 

next page
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Table:



- PADI:
PPPoE Active Discovery Initiation

- PADO:
PPPoE Active Discovery Offer

- PADR:
PPPoE Active Discovery Request

- PADS:
PPPoE Active Discovery Session 
confirmation

- PADT:
PPPoE Active Discovery Termination

- IPv6:
IPv6 Control Protocol

- LCP:
Link Control Protocol

- IPCP:
Internet Protocol Control Protocol

- PAP:
Password Authentication Protocol

ack. = acknowledge

auth. = authentication

conf. = configuration

nak. = not acknowledge

prot. = protocol

rec. = received

rep. = reply

req. = request

rej. = rejected

2x
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In the case of IPv6:

Assigned configuration:
The ARGUS will display the IP 
configuration assigned by the server:
- Global Unicast Address
- Link Local Address





Assigned configuration:
The ARGUS will display the IP 
configuration assigned by the server:
- IP address received
- Gateway IP address
- DNS Server available





<IPv6> IPv6 information will be 
displayed.

<IPv4> IPv4 information will be 
displayed.

Use the cursor keys to scroll to 
additional information.

Close the results display.

Close the results display.

Depending on the IP version

<IPv4>
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11 Services

Four services are presented on the Status screen (see explanation on page 82).
There is an entire group of IP tests that can be performed for each Service (see the table 

below). Furthermore, it is possible to start and stop each service independently of the other 

services.

An example of the display with the possible services.



If a service is activated, a variety of tests can be started with <Test>. The tests that can be 

performed for the various services are as follows:

<Edit> To assign the service a Virtual 
Line (VL) profile and configure 
the service.

<Profile> Configure profile.

<Start> Activate service. If the Virtual 
Line and physical layer are not 
yet activated, they will also be 
started automatically.

Services:

- IP ping - IP ping - IP ping - IP ping

- Trace route - Trace route - Trace route - Trace route

- HTTP download - VoIP call - IPTV

- FTP download - VoIP wait - IPTV scan

- FTP upload - IPTV passive

- FTP server
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11.1 Display the Service Statistics


ARGUS - Status screen
The physical layer, Virtual Line and service 
are activated.





















Use the cursor to select a service 
(in this example, Data)

<Info> Display how long the selected 
service has been activated.

If the VoIP service is selected, 
Info will display the VoIP call 
parameters, see page 167.

Exit the display and return to the 
Status screen.
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12 Test Overview and Hotkey Assignment

Test Overview

Interface 
Test 

ATU-R VTU-R
AUT-R BR

VTU-R BR

ATU-R RT

VTU-R RT
Ethernet

Loop
see page 108

- - x x x

VPI/VCI scan, 

see page 112
x - x*1 x*1 -

ATM OAM ping, 

see page 116
x - x*1 x*1 -

IP ping 
see page 120

x x - x x

Trace route
see page 127

x x - x x

HTTP download, 

see page 132
x x - x x

FTP download, 

see page 139
x x - x x

FTP upload, 
see page 144

x x - x x

FTP server, 
see page 149

x x - x x

VoIP call / Wait
see page 170

x x - x x

IPTV
see page 173

x x - x x

IPTV scan
see page 180

x x - x x

IPTV passive, 

see page 187
- - - x x

*1 = ADSL only

Table of the tests possible on an xDSL or Ethernet access:

In order for the ARGUS to perform these tests (with the exception of the ATM tests: 
VPI/VCI scan, ATM OAM ping and Loop), you must first configure a Virtual Line. The 
configuration of a Virtual Line is described in the chapter devoted to Virtual Lines, see 
page 82.
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Graphic functions:
After setting up an xDSL access or a test, the following graphic functions can be used in the 

result graphics:

Hotkey ADSL/VDSL DMT Analysis

Zoom Zoom

Cursor Cursor

- Tones

- Mode

- Probe

Settings x-axis -

Continue New

Numeric key 2

Numeric key 3

Numeric key 4

Numeric key 5

Numeric key 7

Numeric key 9
ARGUS 141 105



12 Test Overview and Hotkey Assignment
Hotkey Assignment
The ARGUS keypad can be used to call up or start the main functions and/or tests directly. 
The selection of hotkeys available depends on the type of access selected (in the table 
below on an xDSL or Ethernet):

Hotkey Service ADSL VDSL Ethernet

ARGUS-State x x x

Help hotkeys x x x

VPI/VCI scan x - -

IP ping x x x

Trace route x x x

HTTP download x x x

FTP download x x x

Trace/remote x x x

IPTV x x x

VoIP call x x x

Status screen x x x

x x x

x x x

x x x

The speed-dialling memory for numbers, settings (e.g. PPP user 
name, IP addresses etc.), profile / profile names, user-specific 
services, keypad infos and all of the test results stored in the 
ARGUS will be deleted if the settings have not been saved 
before hand, see page 205.

x x x

Numeric key 0

Numeric key 1

Numeric key 2

Numeric key 3

Numeric key 4

Numeric key 5

Numeric key 7

Numeric key 8

Numeric key 9

One after the 

other 

 and  

Quick access to the Access Menu

One after the 

other 

 and

Displays ARGUS-specific information, 
such as ARGUS type, SW version, 
S/N., own MAC addresses, SW options 
etc.

One after the 

other 

 and

Restore the saved settings, see page 
205.

One after the 

other 

 and

All settings will be reset to the default 
factory settings, see page 205.
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Different hotkeys will be available depending on the type of access selected (in this 

example Copper Tests):

Hotkey Service Cu Tests
Status

x

x

x

x

x

x

x

x

The speed-dialling memory for numbers, settings (e.g. PPP user 
name, IP addresses etc.), profile / profile names, user-specific 
services, keypad infos and all of the test results stored in the 
ARGUS will be deleted if the settings have not been saved before 
hand, see page 207.

x

Numeric key 0 ARGUS-State

Numeric key 1 Help hotkeys

Numeric key 5 Send test results to a PC

Numeric key 7 Open speed-dialling memory

Numeric key 8 Trace/remote

One after the 

other 

 and  

Quick access to the Access Menu

One after the 

other 

 and

Displays ARGUS-specific information, see page 106.

One after the 

other 

 and

Restore the saved settings

One after the 

other 

 and

All settings will be reset to the default factory settings, see 
page 205.
ARGUS 141 107



13 Loop
13 Loop

A loop can only be setup on an Ethernet line. A loop will take all incoming Ethernet frames 
at Layer 1 (L1) and send them back to the sender unchanged. 
In the case of a loop on Layer 2 (L2) of the OSI model, the ARGUS swaps the source MAC 
address with the destination MAC address and then sends all the incoming Ethernet 
frames back.

The following parameters are required for the Loop:

Protocol-independent parameters:

ARGUS - Status screen
In this example: Ethernet Access

Test parameters

Loop

Continuation on 

next page


















Select the test to be configured
(in this example, Loop).

Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet 
connection and for the loop.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.
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View and edit 
the marked parameters if 
necessary

Settings
 - Mode
 - Layer
select and edit.










Mode

Layer



Quit the menu without saving 
the changes.

Setting Explanation

Test parameters:

Loop:

Use the Loop Mode to set what should be looped.
 - only those packets sent to own MAC (promiscuous mode off) 
   L1: Only loop packets sent to own MAC address and broadcast packets. 
   L2: Only loop those packets sent to own MAC address.
   Broadcasts will be discarded.
 - loop all packets (promiscuous mode on)   
   L1: All packets (including Broadcast packets) will be looped.
   L2: All packets - with the exception of Broadcast packets - will be looped. 
   Broadcasts will be discarded.
Default setting: only own MAC

This setting determines the OSI Model layer that will be used for the loop. 
 - L1: In the case of loop, all incoming Ethernet frames on Layer 1 (L1) will be 
   sent back to the sender unchanged.
 - L2: In the case of loop on Layer 2 (L2) of the OSI model, the ARGUS will 
   swap the source MAC address with the destination MAC address and then 
   send all incoming Ethernet frames back to the sender.
Default setting: L2
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13 Loop
Start Loop (Access Mode: Ethernet)


Continuation on 

next page

Set up the Ethernet connection

The profile shown in the display 
(in this example, Profile 1) will be used for 
the loop.
























<Start> Activate Ethernet

<Info> Display the Ethernet connection 
parameters

<Test> Display the available tests

<Stop> Stop the Ethernet connection

<Config> Change the loop parameters, 
see Page 109
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The loop is started:


Saving the results
The results of the Loop test are saved in the same manner as for an ADSL access, see 

Page 50.



Duration Current duration of the test.

Looped Displays the number of packets 
looped so far.

Looped 
in 1 
sec.

Displays the number of packets 
looped during the current 
second.

Through-
put

Displays the current data 
throughput per second.

MAC 
Address

Own MAC address of the looped
device (e.g. to enter in the Traffic
Generator).

<Status> Display the Status screen 
without stopping the test.

Duration Total test time

Looped Number of packets looped

Average Number of packets looped per 
second

<Status> Displays the Status screen.
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14 ATM Tests 

The following ATM tests can only be performed on an ADSL interface. Other interfaces, 
such as VDSL or Ethernet are not based on ATM technology.

14.1 VPI/VCI Scan

In a VPI/VCI Scan, the ARGUS checks which VPI/VCI combinations are active on the 

access under test: The ARGUS will send a test packet for each of the possible VPI/VCI 

combinations and wait for a packet in response.

The following parameters, which are stored in a profile, are required to perform a VPI/VCI 

Scan (if a xDSL connection has already been setup, the connection parameters, e.g. the 

ADSL mode and the target value, are blocked):

Protocol-independent parameters:















Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the xDSL 
connection and for the VPI/VCI 
Scan.

The ARGUS will use the marked 
profile as the default profile and 
return to the settings menu.

Continuation on 

next page
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Setting Explanation

Test parameters:

VPI/VCI Scan:

VPI Virtual Path Identifier
This sets the VPI range, which the ARGUS will check during the VPI/VCI scan.
Range: 0 to 255

Default setting: 0 to 8

VCI Virtual Channel Identifier
This sets the VCI range, which the ARGUS will check during the VPI/VCI scan.
Range: 32 to 65535

Default setting: 32 to 48

Number 
of scans

The number of scans. 
Range: 0 to 99

Default setting: 2

Timeout This sets the maximum amount of time that the ARGUS will wait for a response 

from an ATM network node to a test packet which it sent.
Range: 0.1 to 9.9 seconds

Default setting: 0.5 seconds

Test parameters

View and edit the 
marked parameters
if necessary

VPI/VCI scan
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Start a VPI/VCI Scan


In the example, the access is set to ADSL 
and ATU-R is active.











The VPI/VCI Scan starts automatically.




The ARGUS displays the VPI/VCI 
combination currently being tested and the 
last VPI/VCI combination that was found 
to be active (in the example, 1/32).



<Info> Display the ADSL connection 
parameters

<Test> Display the tests possible

<Stop> Stop the ADSL connection

<Config> The ARGUS will display the 
test parameters for the VPI/VCI 
Scan, see Page 113.

<Status> Display the Status screen 
without stopping the test; see 
above.

Cancel the test.

Initialization

VPI/VCI Scan
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After the VPI/VCI Scan has been 
concluded, the ARGUS will show the VPI/
VCI combinations active on the access 
under test. 












Close the results display

For information on saving the results, see 
IP Ping Page 126.

<Status> Display the Status screen

<New> Start a new VPI/VCI Scan

VPI/VCI Scan - results

Save the result?
ARGUS 141 115



14 ATM Tests
14.2 ATM OAM Ping

In an ATM OAM ping test, the ARGUS checks the availabilit of individual ATM network 

nodes or an ATM subnet. OAM is an acronym for "Operation, Administration and 

Maintenance“ and is used for the monitoring and administration of ATM data transmissions.
The following parameters, which are stored in a profile, are required to perform an ATM 

OAM ping (if an ADSL connection has already been setup, the connection parameters, e.g. 

the ADSL mode and the target value, are blocked):

Protocol-independent parameters:

























Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the xDSL 
connection and for the ATM OAM 
ping.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

Continuation on 

next page

Test parameters

ATM OAM Ping
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Setting Explanation

Test parameters:

ATM OAM ping:

VPI / VCI Entry of the VPI and VCI for the ATM OAM ping
Range: VPI: 0 to 255, VCI: 32 to 65535
Default setting: VPI: 1, VCI: 32

Number of 
pings 

This sets the number of test packets that the ARGUS will send. 
If you enter "0", the ARGUS will send packets continuously until the 

ATM OAM ping is stopped manually.
Range: 1 to 99999
Default setting: 3 

Timeout This sets the maximum amount of time that the ARGUS will wait for 

a response from an ATM network node to a test packet which it 

sent.
Range: 0.1 to 9.9 seconds
Default setting: 1 second

OAM cell type F5 The loopback cell will be answered by the first ATM node of the 

virtual channel. The loopback cell will be answered by the first ATM 

node of the virtual channel. 
F5 loopback ete The loopback cell will be answered by the endpoint 

of the virtual channel.
Default setting: F5 loopback ete

View and edit the marked 
parameters if necessary
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Start ATM OAM ping



In the example, the access is set to ADSL 
and ATU-R is active.










The ATM OAM ping test will start 
automatically.


The ARGUS will display the current 
number of test packets sent, the current 
number of packets in response and the 
VPI/VCI on which the ping test is currently 
being run.

<Info> Display the ADSL connection 
parameters

<Test> Display the tests possible

<Stop> Stop the ADSL connection

<Config> The ARGUS will display the 
test parameters for the ATM 
OAM ping, see Page 117.

<Status> Display the Status screen 
without stopping the test; see 
above.

Cancel the test.

Initialization

ATM OAM Ping
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At the end of the ATM OAM ping, the 
ARGUS will automatically display the 
results. If the test has been set to 
"continuous", it must be stopped 
manually: 













For information on saving the results, see 
IP ping Page 126.

- Number of packets sent

- Number of packets received

- Number of packets lost

- Minimum packet round-trip delay

- Maximum packet round-trip delay

- Average packet round-trip delay

<Status> Display the Status screen.

<New> Start a new ATM OAM ping 
test.

ATM OAM ping result

Save the result?
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15 IP Tests

15.1 IP Ping

In the IP ping test, the ARGUS checks whether it is possible to setup a connection to an 

Internet Service Provider (ISP) - or another computer or server address - via an Ethernet 

connection (IP network) or via an xDSL connection (over a DSLAM and the ATM/IP 

network): The ARGUS sends a test packet to a predefined IP address (remote site) and 

then waits for a packet in reply. Based on the received packet, it is possible to evaluate the 

ATM/IP network availability and delay. It is also possible to determine the path's maximum 

data packet size. The following parameters are required for the IP ping:

Protocol independent parameters

ARGUS - Status screen.

<Edit> Setting the ADSL 
parameters.

<Profile> Profile settings are like those 
for ADSL, see page 30.

<Start> Start physical layer.

Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet or 
xDSL connection and for the IP 
ping test.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

Continuation on 

next page

Test parameters
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Setting Explanation

Test parameters:

IP ping:

IP address This is the address of the remote site. The ARGUS can save up to 10 

IP addresses. The saved IP addresses are available to all of the 

profiles.


The ARGUS shows the memory locations 
(a total of ten) available for storing IP 
addresses. Use the cursor keys to mark the 
memory location with the IP address that 
you wish to edit (in this example, the first 
memory location is marked (1/10)).

IP ping

View and edit the 
marked parameters if 
necessary

as name, IPv4 or IPv6 
number

Continuation on next 

page





The address can be entered as an IPv4 
or IPv6 number, or as a name.
Default setting: www.argus.info

<Edit> Open the marked IP 
address to edit it.
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Enter the IPv4 or IPv6 address as a 
number.
Use the numeric keypad to make the entry.

<Delete> Delete the character before 
the cursor.

to 

When entering an IPv6 
address, the key 
combinations can be used 
to enter the letters A to F.

Set the marked IP-address 
as the default address

Use the softkey on the right to shift the 
keypad (the softkey on the right assumes a 
different meaning when pressed):
For information on entering the address as 
a name, see User name on page 94.

<12>ab> Entry of the digits 0 to 9 plus 
* and #

 <ab>AB> To enter lowercase letters 
and @, /, -, .

<AB>12> To enter uppercase 
characters and @, /,- and .

Move the cursor within the 
line.

Number of pings Enter the number of test packets that the ARGUS should send to the 

IP address. If you enter a zero ("0"), the ARGUS will send packets 

continuously until the test is stopped manually.
Range: 1 to 99999
Default setting: 10 

Pause This setting determines the amount of time that the ARGUS will wait 

between sending test packets.
Range: 0.1 to 9.9 seconds
Default setting: 1 second 

Packet size This setting determines the size of the test packets.
By varying the size, it is possible to determine the maximum data 

packet size and the relationship between size and response time.
Range: 36 to 55,555 bytes
Default setting: 84 bytes

IP address as an IPv4 number

IP address as an IPv6 number
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Start IP ping (in the example, Access mode ATU-R, already active):

Set up the service

The profile shown on the display will be 
used for the IP ping (in this example, 
Profile 1).

If no xDSL or Ethernet connection has 
been setup, a connection will be setup 
automatically at this point using the 
default profile (see page 36).


The Data service and ADSL connection 
are active.






Fragmentation This parameter sets the fragmentation:
Default setting: on

on Depending on the network (or router), test packets 

may be divided into multiple packets.

off Fragmentation is not permitted, i.e. the test packets 

may be rejected by the network (or router). In this 

case, the ARGUS will not receive a packet in reply.

auto The ARGUS determines the maximum packet size for 

the path to the destination address (Path-MTU) and 

splits the test packet into smaller packets. These can 

then be sent with the minimum of delay (since the 

network/router need not fragment the test packet).

<Edit> Assign Virtual Lines to the 
Data service. 

<Info> Duration of the activation

<Test> Open test selection

<Stop> Deactivate service

Continuation on 

next page
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n 






The ARGUS displays the address stored 
in the profile.


















e.g. select IP ping

<Config> Change the IP ping 
parameters, see page 
121.

Select the IP address to use for 
the ping; the default address is 
marked with an .

<Edit> Open address for editing, see 
page 121.

<Status> Display the Status screen 
without stopping the test.

In this example, a ping test is being ru
on a line using the IP version IPv4. 
The test would be run in a similar 
manner on a line with IPv6.Continuation on 

next page
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The IP ping will start automatically.

During the IP ping, the display shows:

After the test has run, the ARGUS will 
display the results:

- Number of test packets sent

- The number of packets in reply

- Minimum time in ms

- Maximum time in ms

- Average time in ms

<Destinat.> Displays the URL and IP 
address.

<Status> Display the Status screen 
without stopping the test.

Test Canceled
The ARGUS will display the 
results collected thus far and 
will inquire whether to save 
them (see page 126).

- Number of packets sent

- Number of packets received

- Number of packets sent again

- Checksum error

- Faulty packets received

- Minimum packet round-trip delay in ms

- Maximum packet round-trip delay in ms

- Average packet round-trip delay in ms

<Destinat.> Displays the URL and IP 
address.

<Status> Display the Status screen 
without stopping the test.

<New> Start a new IP ping test

Continuation on 

next page

IP ping

IP ping results
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“Sending the Trace file to a PC”, see page 
97.



A new test can be started if required. The 
xDSL connection and the service are still 
setup (to clear the connection down, press 
<Stop> in the status display).






IP ping – Error messages

If an error occurs, the ARGUS will display 
an error message.



For a description of the error messages, 
please see the appendix, page 219 et seq.

<Yes> The ARGUS will save the result 
of the IP ping test in the first 
available memory location in the 
internal memory (see page 198).

<No> The ARGUS will discard the 
results and return to the previous 
selection menu.

<Status> Displays the Status screen.
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15.2 Trace Route

In an IP Trace route test, the ARGUS sends test packets and then displays a list of all of the 

network nodes (hops) and their response times on the way to the destination address. This 

information can then be used to precisely locate delays in the network.
The following parameters (which are stored in the profile) are required for the IP Trace 

route test:

Protocol-independent parameters:


ARGUS - Status screen













<Edit> Setting the ADSL 
parameters.

<Profile> Profile settings are like those 
for ADSL, see page 30.

<Start> Start physical layer

Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet or 
xDSL connection and for the Trace 
route test.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

Test parameters

Trace route

Continuation on 

next page
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Setting Explanation

Test parameters:

Trace route:

IP address The IP address of the destination node can be entered as an IP 

number or as a name (URL) (for instructions, see IP Ping / IP 

address on page 122).
Default setting: www.argus.info

Maximum hops This sets the maximum number of hops that will be taken in the 

path to the destination node.
Range: 1 to 25
Default setting: 25

Probes This sets the number of attempts that will be made to get a 

response from a network node.
Range: 1 to 10
Default setting: 3 

Timeout This sets the maximum amount of time that the ARGUS will wait for 

a response from a network node.
Range: 0.05 to 9.9 seconds
Default setting: 3 seconds

Edit the marked 
parameters if necessary 
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Start Trace Route 

(In the example: Access mode ATU-R, already active)

Set up the service.



The profile shown on the display will be 
used for the Trace route test (in this 
example, Profile 1).


If no xDSL or Ethernet connection has 
been setup, a connection will be setup 
automatically at this point using the 
default profile (see page 36).

The Data service and ADSL connection 

are active.








<Edit> Assign a Virtual Line to the 
Data service.

<Info> Duration of the activation

<Test> Open test selection

<Stop> Deactivate service


e.g. select Trace route

<Config> Change the Trace route 
parameters, see page 127.

Continuation on next 

page
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The ARGUS displays the IP address or 

URL stored in the profile.

The Trace route test will start 
automatically.

During the Trace route test, the display 
shows:

Display after the Trace route has been 
run:

Select the address to use for the 
Trace route test; the default addres
is marked with an .

<Edit> Open the address to be edited, 
for more information, see page 121

In this example, a Trace route is bein
run on a line with IP version IPv4. 
The test would be run in a similar 
manner on a line with IPv6.

- The current hop and probe (in the 
example 1 -3: i.e. first hop and 3rd probe

- Response time of the hop in the current 
probe (0.035 seconds)

- The IP address of the current hop; in this
example, 217.0.116.223

<Destinat.> Displays the URL and IP addr

<Status> Display the Status screen with
stopping the test.

Cancel Test
The ARGUS displays the test
determined up to this point an
whether it should save them.

- All the hops and an OK / FAIL evaluation
are displayed.

<Detail> Displays the IP address of the 
hop as a name (if possible).
The details of the hop, which is 
at the top of the list shown 
above, will be displayed (in this 
example, hop 1).

Initialization

Trace route

Trace route result
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Close the results display.

Save the Trace route results, also see IP 
ping (seepage 126).
Sending the Trace file to a PC (see page 
97).

Save the result?
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15.3 HTTP Download

In the HTTP download test, the ARGUS will attempt to download data from a web site or 

file. The ARGUS will display the current "net download rate", the user data of the IP 

packets, and once the HTTP download is over the average speed (in the case of multiple 

download attempts). The following parameters (which are stored in the profile) are required 

for the HTTP download:

Protocol-independent parameters:

ARGUS - Status screen.













Since it is not possible to accurately determine the transmission speed if the 
duration of the download test is less than 10 seconds, you should download a 
reasonably large file (taking into consideration the access speed). If the test 
duration is less than 10 seconds, the ARGUS will not show any data rate or time 
at the end of the test.

<Edit> Setting the ADSL 
parameters.

<Profile> Profile settings are like those 
for ADSL, see page 30.

<Start> Start Physic (physical layer)

Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet or 
xDSL connection and for the HTTP 
download test.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

Continuation on 

next page

Test parameters
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Select HTTP download.












Ten user-defined server profiles are 
available which will also be used for both 
the FTP download and upload tests.









Edit the marked server profile.

Edit the marked parameters if necessary
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Setting Explanation

Test parameters:

HTTP download:

Server 
profile:

A total of up to 10 user-defined server profiles can be created. These 
server profiles will then be available for the HTTP download, FTP 
download and the FTP upload tests. The profiles hold all of the 
parameters required for the HTTP download, FTP download and the 
FTP upload.

Server Enter the IP address or URL of the server from which the ARGUS 
should download the file. In the case of an Upload test: Enter the upload 
destination (server address) to which the ARGUS should send the data.
For information on the softkeys, see page 121.

Download 
filename

The name of the file that the ARGUS should retrieve in the download 
test (HTTP download or FTP download). 
When entering a www address alias, please see page 135)
For information on the softkeys, see page 121.

Upload 
filename

The filename under which the data – sent in the FTP upload test – 
should be saved on the server.
Default setting: file

Upload 
file size

Sets the size of the file that the ARGUS will send in the FTP upload test.
Range: 0 to 999 999 999 bytes
Default setting: 1 000 000 bytes

User name Entry of the user name for the (FTP or HTTP) server.
For more information on the operation, see page 121.

Password Entry of the password for the (FTP or HTTP) server.
For more information on the operation, see page 121.

Number of 
up-/
downloads

The number of times that the ARGUS will retrieve the data from the 
source address in a Download test. In the case of an Upload test: This 
sets how often the ARGUS will send the data of the file to the 
destination. "Zero“ means continuously. In which case, the test must be 
terminated manually.
Range: 1 to 9 999 (0 = continuous)
Default setting: 3

Number of 
parallel 
downloads

The number of packets into which the requested download should be 
divided and downloaded in parallel (see page 135). 
Range: 1 to 10 
Default setting: 3

Profile name Entry of a name for the profile
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If an alias www address is entered as the "Source/Destination" address, the 

ARGUS will "only" download the one HTML page during the HTML download 

test. The ARGUS does not evaluate the HTML code, so any link to a “true” www 

address will be ignored. In this case, the ARGUS will not display an error 

message since the “Source/Destination” address specified will have been loaded 

without error.

When entering the “Source” address (server address and download filename) 

make certain that you use the correct notation (upper and lower case), otherwise 

the ARGUS will report an Error 301 (Moved Permanently) or Error 404 (Not 

Found).

If the ARGUS requests multiple downloads, it will reduce the number of 

downloads requested to suit the number of downloads supported by the server. 

This may result in a deviation from the parameters set. This can, for example, be 

the case if the size of the requested file is unknown.

Where the name of the file to be downloaded exceeds the maximum permissible 

length, it is possible to get around this by using the "Server" field for part of the 

address.
The server name may be up to 80 characters long while the file name may be 60 

characters long.
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Start HTTP download (in this example: Access mode ATU-R, is already active)

Set up the service.



The profile shown on the display will be 
used for the HTTP download (in this 
example, Profile 1).



If no connection has been setup, a 
connection will be setup automatically at 
this point using the default profile (see 

page 36).





<Edit> Add a Virtual Line to the Data 
service.

<Info> Duration of the activation

<Test> Open test selection

<Stop> Deactivate service


e.g. select HTTP download

<Profile> Display the available 
HTTP download profiles 
profile, see page 133.

Continuation on 

next page
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Select the server profile: 
(The default is marked with an ).




The HTTP download will start 
automatically.

During the HTTP download, the display 

shows:

<Edit> Edit the marked profile
For information on changing 
the individual settings, see 
page 134.

- Current download / Total downloads
In the example, the first download 
attempt of a total of three (1/3) is shown.

- The amount of data already loaded (in 
the example, 10%)

- Current net download rate (in the 
example, 20.662 Mbit/s)

- The number of bytes already loaded (in 
the example, 59.922 MB)

- Size of the file to be downloaded (in the 
example, 95.367 MB)

- Current loading time in h:min:s

- Remaining loading time in h:min:s

- Number of parallel downloads

<Status> Display the Status screen 
without stopping the test.

Cancel the test.

Initialization

HTTP download
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Display results:













Close the results display

For information on saving the HTTP 
download results, see page 125.
“Sending the Trace file to a PC”, see page 
97.




<Status> Display the Status screen

<New> Start a new HTTP download

- Calculated average speed of all of the 
downloads (in the example, 20.847 Mbit/s)

- Size of file loaded 
(in the example, 95.367 MB)

- Average time required for a download in 
h:min:s

- Maximum parallel downloads

- Configured parallel downloads

HTTP download results

Save the result?
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15.4 FTP Download 

In the FTP download test, the ARGUS will attempt to download a file. The ARGUS will 

display the current net download rate, the user data of the IP packets, and once the test is 

over the net average speed (in the case of multiple download attempts). The following 

parameters (which are stored in the profile) are required for the FTP download:

Protocol-independent parameters:

ARGUS - Status screen.

















<Edit> Setting the ADSL 
parameters.

<Profile> Profile settings are like those 
for ADSL, see page 30.

<Start> Start Physic (physical layer)

Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet or 
xDSL connection and for the FTP 
download.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

Test parameters

FTP download

Continuation on 

next page
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Ten user-defined server profiles are 
available which will also be used for both 
the HTTP download and the FTP 
download tests.












In the case of a download test of less than 10 seconds, it is not possible to 
accurately determine the transmission speed. Consequently, it is advisable to 
download as large a file as is reasonable given the speed of the access. If the test 
duration is less than 10 seconds, the ARGUS will not show any data rate or time 
at the end of the test.

FTP download parameters, see page 134

Server IP address or URL of the 
FTP server

Download 
filename

The path and name of the 
file to be downloaded in 
the FTP download test

User name User name for the FTP 
server

Password The password for the FTP 
server

Number This sets how often the 
data at the “Source” 
address should be 
downloaded

Profile name Name of the server profile

View and edit the marked 
parameters if necessary
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Start an FTP download (in this example: Access mode ATU-R, is already active)

Setup the service

The profile shown on the display will be 
used for the FTP download (in this 
example, Profile 1).

If no connection has been setup, a 
connection will be setup automatically at 
this point using the default profile (see 
page 36).

















<Edit> Add a Virtual Line to the Data 
service.

<Info> Duration of the activation

<Test> Open test selection

<Stop> Deactivate service


e.g. FTP download

<Profile> Display the available FTP 
download profiles, see 
page 140.

Continuation on 

next page
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Mark the server profile (the default profile 
is marked with a ).







The FTP download will start automatically.




During the FTP download, the display 

shows:

<Edit> Edit the marked profile
For information on changing 
the individual parameters, see 
page 134.

- Current download / total downloads
In the example the first download of a 
total of three (1/3) is shown.

- The amount of data already loaded (in 
the example, 13%)

- Current net average download rate 
(in the example, 20.548 Mbit/s)

- The number of bytes already loaded (in 
the example, 87.458 MB)

- Total size of file to be loaded (in the 
example, 95.367 MB)

- Current duration of the download in 
h:min:s

- Remaining loading time

- Number of parallel downloads

<Status> Display the Status screen 
without stopping the test.

Cancel the test.

Initialization

FTP download
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s)





Display after the FTP download has 

finished:











Close the results display.

For information on saving the results, see 
IP ping page 125.
Form more on sending the trace file to a 
PC, see page 97.

<Status> Display the Status screen.

<New> Start a new FTP download

- Calculated average speed of all the 
downloads (in the example, 20.823 Mbit/

- Size of file loaded 
(in the example, 95.367 MB)

- Average time required for a download in 
h:min:s.

- Maximum parallel downloads

- Configured parallel downloads

FTP download results

Save the result?
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15.5 FTP Upload

In an FTP upload, the ARGUS sends the data in a file to a server. The ARGUS will display 
the current net upload rate, the user data of the IP packets, and once the test is over the 
net average speed (in the case of multiple upload attempts). The following parameters 
(which are stored in the profile) are required for the FTP upload:

Protocol-independent parameters:

ARGUS - Status screen.















Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet or 
xDSL connection and for the FTP 
upload.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

<Edit> Setting the ADSL 
parameters.

<Profile> Profile settings are like those 
for ADSL, see page 30.

<Start> Start Physic (physical layer)

FTP upload

Test parameters

Continuation on 

next page
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Ten user-defined server profiles are 
available which will also be used for both 
the HTTP download and the FTP 
download tests.











Edit the marked server profile.



In the case of an upload test of less than 10 seconds, it is not possible to 

accurately determine the transmission speed. Consequently, it is advisable to 

upload as large a file as is reasonable to the server given the speed of the 

access. If the test duration is less than 10 seconds, the ARGUS will not show 

any data rate or time at the end of the test.

FTP upload parameters, seepage 134

Server IP address or URL of the 
FTP server

Upload 
filename

The path and filename 
under which the file that is 
sent in the test should be 
saved on the server.

Upload file 
size

The size of the file sent

User name User name for the FTP 
server

Password Password for the FTP 
server

Number Number of uploads

Profile name Name of the server profile

View and edit the marked 
parameters if necessary
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Start FTP upload (in this example: Access mode ATU-R, is already active)


Set up the service.

The profile shown on the display will be 
used for the FTP upload (in this example, 
Profile 1).


If no connection has been setup, a 
connection will be setup automatically at 
this point using the default profile (see 
page 36).








<Edit> Assign Virtual Lines to the Data 
service.

<Info> Duration of the activation

<Test> Open test selection

<Stop> Deactivate service



e.g. FTP upload

<Profile> Display the available FTP 
upload profiles, see page 
145.

Continuation on 

next page
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Mark the server profile (the default profile 
is marked with a )












The FTP upload will start automatically.

During the FTP upload, the display shows:






<Edit> Edit the marked profile
For information on changing the 
individual parameters, see page 
134.

- Current upload / total uploads
In the example, the first upload of a total 
of three (1/3) is shown.

- The amount of data already sent (in the 
example, 84%)

- Current net upload rate (in the example, 
1.685 Mbit/s)

- The number of bytes already sent
(in the example, 667.230 KB)

- Total file size (in this example, 0.953 MB)

- Current duration of the upload in h:min:s

- Remaining transfer time (sending)

<Status> Display the Status screen 
without stopping the test.

Cancel the test.

Initialization

FTP upload
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Display results:







For information on saving the results, see 
IP ping page 125.
For more on sending the trace file to a PC, 
see page 97.

- Calculated average bitrate of all 
uploads

- The size of the file sent

- The average time required for an 
upload 

<Status> Display the Status screen

<New> Start a new FTP upload

FTP upload results

Save the result?
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15.6 FTP Server

In FTP server mode, the ARGUS acts as a server for FTP requests. In this case, the 
ARGUS will handle both FTP download and upload requests. 
These requests can be sent by a second terminal (e.g. a second ARGUS) on an xDSL or 
Ethernet connection.
In this manner, it is possible to perform an end-to-end test of the throughput and determine 
the highest average transfer rate attainable for this connection.

The throughput test is illustrated in the following on an Ethernet interface.
In this example, two ARGUS testers are used. One is used as an FTP server while the 
second requests an FTP download.

ARGUS 1 - FTP Server

No settings need to be made on the ARGUS that acts as the FTP Server. Simply start the 
FTP Server single test on the selected interface. 

Start FTP Server (in the example: Ethernet is already active)

Continuation on 

next page

Set up the service.

The profile shown on the display 
(in this example, Profile 1) will be used for 
the FTP server.





If no connection has yet been setup, a 
connection will be setup automatically at 
this point using the default profile, see 
page 36.

<Edit> Assign a Virtual Line to the 
Data service.
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Initialization



The ARGUS will use the IP address 
entered in own "local IP address" as the 
destination address (Server) for the 
second ARGUS.

<Status>



ARGUS 1 will now wait for an FTP request from a second terminal (in the example, a 
second ARGUS).
The IP mode in the example is "static", the IP netmask is in the default configuration.


e.g. FTP Server

Display the Status screen 
without stopping the test.
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ARGUS 2 - FTP Download / Upload

As far as the ARGUS that will issue the FTP requests (in this example, FTP download) is 
concerned, basically the same settings can be used as in the case of an FTP download 
test.
Netmask and local (own) IP address (IP mode: static) should match the settings of 
ARGUS 1.

Start an FTP Download:

Set up the service.



The profile shown on the display (in this 
example, Profile 1) will be used for the 
FTP server.




Continuation on 

next page


If no connection has yet been setup, a 
connection will be setup automatically at 
this point using the default profile (see 
page 36). 



<Info>

<Test>

<Stop>

<Edit> Assign a Virtual Line to the Data 
service.

Duration of the activation

Open test selection

Deactivate service
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Continuation on 

next page







<Profile>

Mark the server profile (the default profile 
is marked with a ).

<Edit>







e.g. FTP Download

Edit the FTP Download 
parameters, see page 140.

Edit the marked profile
For information on changing 
the individual parameters, see 
page 134.
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Download filename





In the server profile of ARGUS 2, just 
enter the IP address of ARGUS 1 in the 
Server IP address, see page 150.

<Delete>

<12>ab>










Here the download file name is, at the 
same time, the size of the file to be 
downloaded.
The download file name: 1 000 000 000
equals a file size of: 1 GB








In the case of a download test of less than 10 seconds, it is not possible to 
accurately determine the transmission speed. Consequently, it is advisable to 
upload as large a file as is reasonable to the server given the speed of the 
access. If the test duration is less than 10 seconds, the ARGUS will not show 
any data rate or time at the end of the test.







Delete the character before 
the cursor

see page 94
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al 

:s
FTP download

Server profile

Initialization





<Edit>

The FTP download will start automatically.

During the FTP download, the display 

shows:

<Status>



Edit the marked profile
For information on changing 
the individual parameters, see 
page 134.

- Current download / total downloads
In the example the first download of a tot
of three (1/3) is shown.

- The amount of data already loaded 
(in the example, 3%)

- Current net average download rate 
(in the example, 70.996 Mbit/s)

- The number of bytes already loaded
(in the example, 200.824 MB)

- Total size of file to be loaded
(in the example, 952.153 MB)

- Current duration of the download in h:min

- Remaining loading time

- Number of parallel downloads

Display the Status screen 
without stopping the test.

Cancel the test.
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s)
Display after the FTP download has 
finished:







Close the results display.






For information on saving the results, see 
IP ping page 125.
For more on sending the trace file to a PC, 
see page 97.

<Status> Display the Status screen.

<New> Start a new FTP download

- The calculated average speed of all the 
downloads (in this example, 72.550 Mbit/

- The size of file loaded (in the example, 
356.770 MB)

- Average time required for a download in 
h:min:s.

- Maximum parallel downloads

- Configured parallel downloads

Save the result?

FTP download results
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16 VoIP Tests

The ARGUS acts as a VoIP terminal with which a telephone (voice) call can be set up. The 

ARGUS uses the Session Initiation Protocol (SIP) as the signaling protocol for VoIP. VoIP 

calls can be set up with or without a registrar or proxy. The ARGUS can be used to setup a 

VoIP connection (DSL telephony) via xDSL or Ethernet. The MOS/R-factor of the RTP data 

stream will determined and displayed as an evaluation of the voice quality.
Three "VoIP accounts (Profiles)" can be configured for use in VoIP telephony:

Protocol-independent parameters:

ARGUS - Status screen.








Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet or 
xDSL connection and for the VoIP 
test.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

<Edit> Assign a Virtual Line to the 
VoIP service.

<Profile> Profile settings are like those 
for ADSL, see page 30.

<Start> Start service

Continuation on 

next page

Access parameters

Service VoIP
156 ARGUS 141 



16 VoIP Tests







A total of 3 user-defined VoIP profiles can 
be configured.








Edit the marked profile.






<Edit> Edit the VoIP profile.

VoIP account

Edit the marked 
parameters if 
necessary
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Setting Explanation

VoIP account settings:

VoIP: Up to 3 user-defined VoIP profiles can be created.
<Edit> The selected profile will be opened for editing.

SIP User name User name for the registrar, for more information, see  
page 94.

Password Password for the registrar, for more information, see 
page 94.

Registrar 
Server

Use Registrar: Setting: yes or no.
A registrar must also be used if an Internet Telephony 
Service Provider (ITSP) is used (in such case, you will 
dial a normal telephone number). A registrar is not 
needed if you dial a VoIP telephone directly, e.g. via its IP 
address or the SIP URI.
Default setting: No

Outbound 

Proxy/SBC
Use proxy (SBC = Session Border Controller)
This setting specifies whether or not to use outbound 
proxy. Default setting: No

Outbound Proxy/SBC: Address of the Proxy Server

Outbound Proxy/SBC Port: Port of the outbound proxy 
server
Range: 0 to 65535
Default setting: 5060

SIP domain Configuration of the domain name for the “From” field in 
the SIP message (when using an ITPS). 

Listen port The port used for the incoming SIP signaling. 
Range: 0 to 65535
Default setting: 5060

Remote port The port used by the remote end: 
When using a registrar (see Registrar Server Setting on 
page 158), enter the port number of the Registrar/Proxy 
Server; otherwise, enter the port number of the remote 
end.
Range: 0 to 65535 
Default setting: 5060

Authentication Addtional xTU-R password used for proper authentica-
tion with the registrar.
For more information, see page 94
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SIP

(Continuation)

Caller ID Optional entry of any text desired which will then be 
displayed on the called party's equipment instead of the 
caller's phone number.
For information on the softkeys, see page 94.

User agent ID-string or terminal type which will be sent to the called 
party.
Default setting: Argus141

Qualify Specifies whether or not the proxy server’s availability 
should be checked continuously. 
Default setting: No

Reg. Expire Specifies how long a registration with the registrar server 
is valid. 
Range: 10 to 6000 seconds
Default: 3600 seconds

Del. exist.
registrar

Delete the registration with the registrar server. When set 
to "yes", the ARGUS will be exclusively registered with 
the registrar server.If it is set to "no", it will be put in the 
list of existing registrations. 
Default setting: Yes

Phone 

Settings

RTP port 

range

The SIP signaling and RTP data will be sent to different 
ports. The port range used for RTP can be configured for 
use e.g. with a router. 
Range: 0 to 65535
Default: 
Start: 10 000 
End: 20 000 

Silence
detection

If this is set to “ON”, the ARGUS will not send speech 
packets when there is silence (a break in the speech). 
This can, however, lead to problems with the assignment 
of ports if there is a NAT router in the path. If this setting 
is set to "not used", the (remote) link partner will not be 
notified as to "silence detection" setting. The 
setting will, however, remain.
Default setting: Off
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Phone

Settings

(Continuation)

Jitter buffer Sets whether the size of the jitter buffer is static or 
adaptive. Default setting: static

static: Entry of the size of the static jitter buffer
Range: 20 to 200 ms
nominal: 60 ms

adaptive: Entry of the minimum (min) and 

maximum (max) sizes of the jitter buffer 

and the initial value (init). 
Range: 20 to 600 ms
Default setting:
min: 60 ms
init: 60 ms 
max: 120 ms

Codecs Preparation of a list of voice codecs to be used. If there 

are multiple codecs in the list, the priority is determined 

by the order in the list.

Switch between softkey sets

<> The marked codec will be moved down 

one place in the list.

<> The marked codec will be moved up one 

place in the list.

<Insert> A display of the still available voice 

codecs will open. If a voice codec is 

marked with a  in this Codec 

Selection list, it will be added to the 

Codec Priority list (in the active list of 

voice codecs)

<Delete> Delete the marked codec from the list 

Apply the codec priorities
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Phone

Settings

(Continuation)

DTMF 

Settings

DTMF (Dual-tone multi-frequency) is a multi-frequency 

dialling mode.Mode: 
DTMF mode settings
Choose one of the following settings "automatic", "SIP 

Info", "RFC 2833" or "inband".
Default setting: automatic
Duration: The VoIP DTMF Time setting
Range: 40 to 1000 ms
Up to 200 ms in increments of 10, 200 to 300 ms in 

increments of 20, 300 to 1000 ms in increments of 100. 

Default setting: 80 ms

  Increase or decrease VoIP DTMF time.

STUN server Use STUN Use STUN: Setting: yes or no. If there is a NAT router 
between the ARGUS and the next remote end 
(gateway), you must use STUN so that the ARGUS can 
determine which IP address is seen for it (the ARGUS) 
by the other end.Default setting: No

STUN server STUN Server: Specifies the address of a STUN server 
which must be located in the same network (on the same 
level) as the remote end.

MOS 
threshold

Entry of the MOS threshold:
The MOS value (Mean Opinion Score) is an evaluation of the quality of 
the speech data. The MOS quality scale ranges from 5 (excellent) down 
to 1 (bad). The ARGUS will compare the MOS value of the currently 
active VoIP connection to the MOS threshold value and will display "OK", 
if the current MOS value is at least as good as the MOS threshold value - 
or "FAIL" - if it is not.
Range: 1.0 to 5.0
Default: 4.0

The MOS value determined here is the MOSCQE (Conversational Quality 

Estimated). This value can be strongly influenced by the codec used.

Profile 
name

Enter or change the name of the edited VoIP profile

Value 5 4 3 2 1

Voice quality excellent good fair poor bad
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VoIP QoS (Quality of Service)

Layer 3
DiffServ 

Differentiated Services: Classification/Prioritization of IP packets (L3)

RTP 

(ToS/DSCP)

ToS Type of Service
Field used to set the prioritization in the IP header of the 
user data (RTP), for more infomation, see page 122.
Range: 0 to 0xFF
Default setting: 18

DCSP Differentiated Services Codepoint 
Field used to set the prioritization in the DS field (6 bits) 
of the user data (RTP), for more information, see page 
122.
Range: 0 to 0x3F
Default setting: 00

SIP 

(ToS/DSCP)

ToS Type of Service
Field used to set the prioritization in the IP header of the 
SIP data (signaling), for more information, see page 122.
Range: 0 to 0xFF
Default setting: 18

DCSP Differentiated Services Codepoint 
Field used to set the prioritization in the DS field (bits) of 
the SIP data (signaling), for more information, see. page 
122.
Range: 0 to 0x3F
Default setting: 00

Layer 2 
VLAN prio

The VLAN prioritization on Layer 2 (L2) is an extension of the Ethernet 
header.

RTP VLAN 

prio

VLAN prioritization of user data (RTP).
Range: 0 to 7
Default setting: 0

SIP VLAN 

prio

VLAN prioritization of SIP data (signaling).
Range: 0 to 7
Default setting: 0
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16.1 Start VoIP Telephony

(Example: ADSL access already active)
Set up the service.


The profile used to set up the xDSL 
connection (in this example, Profile 1) will 
also be used for VoIP telephony.



If no xDSL connection has been setup, a 
connection will be setup automatically at 
this point using the default profile (see 

page 36).












<Edit> The default Virtual Line profile 
will be opened for editing.

<Info> Duration of the activation

<Test> Open test selection

<Stop> Deactivate service


e.g. select VoIP call

Continuation on 

next page
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Mark VoIP destination
(default is marked with a  ).

Move the cursor down to select an empty 
line and add a new VoIP destination 
using <Edit>.




Set up a connection

The ARGUS will display its "own call 
number" (From: 7087) and the subscriber 
number called (To: 87). The subscriber 
called has not yet accepted the call: 
display shows "Connecting!" and a yellow 
"CALL" icon.




The subscriber called has accepted the 
call; the display shows “Connected!”. The 
ARGUS will determine the MOS value and 
will indicate whether the speech quality 
meets or exceeds the MOS threshold set 
(see page 161) - i.e. will display "OK" or 
"Fail". The ARGUS will also show the 
evaluation of the MOS value in 
accordance with ITU-T P.800 (in this 
example, "Good"). Furthermore, it will 
display the duration of the connection and 
the currently used voice codec (in this 

example, G.711 A-law, see page 160).

<Edit> Open the VoIP destination 
number for editing

<Info> Display of the VoIP parameters.

<Status> Display the Status screen 
without stopping the test; see 
page 166. 

<Volume> Opens the volume setting.
Continuation on 

next page

Initialization

Continuation on next page, 

second screenshot.
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Setting the volume:









Display of the other VoIP results:

<Extern> Headset operation

<Intern> Handset operation

<OK> Settings confirmed

Display MOS info:

-
-
-
-


-

Current MOS
Average MOS
Min./max. MOS value
Ideal MOS (MOS possible without 
interference, depends on Codec)
Current and average 
R-Factor in accordance with ITU-T 
G.107

Return to the previous display.

Packet statistics:

-
-
-


-




-


Packets received (Rx)
Packets sent (Tx)
Error counters:
RTP drop
RTP error
RTP jitter Rx:
Current jitter
Average jitter
Minimum jitter
Maximum jitter
RTP packets lost (Rx) 
(total, current, average, min. and max.)

Return to "outgoing call"

<Info>

Continuation on 

next page
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Content of RTCP
Display of the statistics sent by the link 
partner:
- Current jitter at the link partner (remote 
  end) Rx (far)
- Average jitter far (remote end)
- Maximum and minimum jitter at the link 
  partner
- RTP packets lost at the link partner
  Rx (far): Total, current, average,
   min. and max.
- Network delay calculated from the RTCP 
  packet transfer time: current, average, 
  min., and max.

If the message "no data" is displayed, 
RTCP is not supported by the link partner 
(remote end).

The ARGUS will display the codecs 
supported by the link partner.








ARGUS - Status screen. 
The VoIP service still has a test active 
(indicated by the green "hammer" icon).




Open the “outgoing call" display

<MOS> Return to the "MOS info" display.


or

Display the Status screen 
without stopping the test.

<Status> In ARGUS Status, see page 
164.


Use the cursor keys to select VoIP 
service

Continuation on 

next page
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The ARGUS will display how long the 
VoIP service has been active, as well as 
the user name and protocol used.







The ARGUS shows the registration 
details before, during and after the 
connection. The setting "Use Registrar" 
must be set to "yes" for this purpose.

<Test> Display the results summary

<Info> or

 

Display the VoIP call 
parameters.

<SIP> Display the registration details: 
Status codes, register IP, register 
used, Outbound Proxy/SBC and 
URI used etc.

<Log.> Displays the VoIP service SIP 
commands, see page 168.

Continuation on 

next page
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The ARGUS will display the VoIP service 
SIP commands.

Other info ((see chapter G) VoIP SIP 
status codes page 223).























The ARGUS can be called while VoIP 
service is active. An incoming call will be 
indicated with yellow Call icon. The 
incoming call can be accepted or rejected.
To have incoming calls accepted 
automatically, start the "VoIP wait" test, 
see page 171.



<Time> Appends a timestamp to all 
events.

The timestamp is based on the 
internal system clock of the 
ARGUS, see page 203

<Reject> Reject call.
Switch to the Status screen.

<Accept> Accept call.
Open the ARGUS-State.

Incoming call:
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Display / Meaning

SIP Log Log showing the SIP methods exchanged and 
status codes.

Register state The ARGUS shows all of the important 
registration and registrar info in the Register State 
Display.

VoIP Features at a Glance

During and after a successful registration:

During a call or a connection:

Display / Meaning

MOS value, Voice codec Current MOS value, current 
voice codec used.

SIP Log: Log showing the SIP methods exchanged and status 
codes.

INFO: MOS results: Threshold: Shows whether the value stayed within 
the preconfigured MOS threshold.

P.800: Evaluation in accordance with ITU-T P.800

MOS value: current/average/min./max.

R factor: current/average/min./ideal

INFO: RTP results: RTP packets: received / sent

RTP drop: RTP packets received but discarded by 
the jitter buffer.

RTP error: RTP packets received but defective.

RTP jitter Rx: current / average / min. / max. 
(calculated in accordance with RFC 3550 per sec.)

RTP packet loss Rx: current / average / minimum 
/ maximum in percent

RTP packet loss total number:
(RTP packets not received)

INFO: RTCP results:
 

RTP jitter remote end: current / average / 
minimum / maximum

(The content of the RTCP packets 
will be displayed if this is sup-
ported by the remote end.)

RTP Packet Loss - remote end: current / 
average / minimum / maximum in percent

RTP packet loss - remote end
Total number

Network delay: current / average / minimum /
maximum (Calculated on the basis of RTCP packets 
exchanged)
ARGUS 141 169



16 VoIP Tests
16.2 VoIP Wait

When running the "VoIP Wait" test, the ARGUS behaves like a VoIP telephone.
To run the "VoIP Wait" test, the parameters for "VoIP call"  (see page page 158) and "VoIP 
Wait" must be configured:

Continuation on 

next page

Set up the service.


The profile used to set up the xDSL 
connection (in this example, Profile 1) will 
also be used for "VoIP wait".




<Edit>




If no xDSL connection has been setup, a 
connection will be setup automatically at 
this point using the default profile (see 
page 36).
















<Config>

The default (preset) Virtual 
Line profile will open for 
editing.

Opens the call accept mode for 
"VoIP wait".
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The "VoIP wait" test supports

 - Automatic
 - Echo test
Default setting: Automatic


Start VoIP wait

Continuation on 

next page

Initialization

The VoIP service and the ADSL 
connection are active.

















The ARGUS will use the user 
name entered under the SIP 
parameters as its own number, 
see page 158.




Select "VoIP wait"
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The ARGUS will wait for a VoIP call.










<Status>




The ARGUS will accept the call (see 
setting page 171) automatically.


The call (connection) parameters are 
explained in the section on VoIP calls, see 
page 164 et seq..








Call clearing: 

The connection is cleared down in the same manner as it is after an IP ping. 
However, pressing the "Cancel" key once will only clear down the connection (if 
there is one). The ARGUS will remain registered with the registrar (VoIP service 
active) so the ARGUS can still be called (an incoming call can be rejected or 
accepted). Deactivate the VoIP service to clear the registration with the registrar. 
In this case, the existing connection will, however, not be cleared down.

Open ARGUS Status, see 
page 164.
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17 IPTV Tests 

17.1 IPTV

The ARGUS requests a data stream from a server (Depending on the type of access, the 

ARGUS will substitute for a settop-box (STB) or modem and STB) and checks the 

regularity of the incoming packets, the loss of packets and the programme's switch on or 

zapping time. Up to three user-defined "IPTV Profiles“ can be configured (when the xDSL 

connection has already been setup the access parameters, e.g. the ADSL mode and the 

target value are locked):

Protocol-independent parameters:

ARGUS - Status screen.

The IPTV-STB emulation is performed 
using the "IPTV" service. 
The following example shows the 
procedure and considers its special 
aspects.








<Edit> Assign Virtual LinesVirtual 
Lines to the IPTV service. 

<Profile> Profile settings are like those 
for ADSL, see page 30.

<Start> Start service

Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet or 
xDSL connection and for the IPTV 
test.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

Continuation on 

next page

Test parameters

IPTV
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Setting Explanation

Test parameters:

IPTV: <Edit> The selected profile will be opened for editing.

Channel 
selection

The channel list can be used and edited for all profiles. Up to 250 

channels can be created. A configuration can also be conveniently 

prepared using the WINplus software on a PC.
Selection of the TV test channels for the IPTV test:
<Edit> The channel is opened for editing.

Multicast IP Entry of the multicast IP. 
Range: 0.0.0.0 to 255.255.255.255
Default setting: 224.0.0.0

Port Entry of the port 
Range: 0 to 65535
Default setting: 0

Alias name Entry of a station name for the IPTV channel

IGMP version Version of the management protocol to log on/off of a multicast group.
Range: 2 to 3
Default setting: 3

Threshold Setting of the threshold values for the IPTV test. 
If these values are exceeded during the IPTV test, the test will display 

the assessment "FAIL"; otherwise "OK" will be displayed.
If an "*" is entered, the corresponding threshold will not be checked.

View and edit the 
marked parameters if 
necessary
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17.1.1 Multiple Virtual Lines

The ARGUS can use up to 4 Virtual Lines for the IPTV service. In this case, the IGMP VL is 
used for the transport of the IGMP protocol and Virtual Lines 1 to 3 are used to receive the 
video/audio streams.

The selected Virtual Line Profile in overview.




Switch between softkey sets


PCR jitter Setting the threshold values for PCR jitter.
Range 0 to 2 000 ms
Default setting: 8 ms

Total RTP 
loss ratio

Setting of the threshold value for the RTP loss ratio for the entire test.
Range: 0.00% to 100.00%
Default setting: 5.00%

<Delete> Remove the selected virtual 
profile (in this example, Virt. 
Profile 1) from the list.

<Change> The selected virtual profile (in 
this example, Virt. Profile 1) will 
be replaced by the newly 
selected virtual profile.

<Edit> Edit the selected virtual profile 
(in this example, Virt. Profile 1), 
see page 89.

<> The marked profile will be 
moved down one place in 
the list.

<> The marked profile will be 
moved up one place in the 
list.
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Start IPTV

Set up the service.

The profile used to set up the xDSL 
connection (in this example, Profile 1) will 
also be used for IPTV.



Activate the IPTV service.






If no xDSL connection has been setup, a 
connection will be setup automatically at 
this point using the default profile (see 
page 36).







<Edit> Assign a Virtual Line to the IPTV 
service or edit it.

<Info> Duration of the activation

<Test> Open test selection

<Stop> Deactivate service

<Config> Display the IPTV configuration, 
see page 174.

Continuation on 

next page
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t 

Select the IPTV channel 
(the default profile is marked with a ).








The IPTV test will start automatically.








During the test, the ARGUS displays the 
selected IPTV channel, the duration of the 
test and the current bitrate. If the 
measured values exceed the threshold 
limits in the settings, the ARGUS will 
report that the IPTV test failed (FAIL); 
otherwise it will display "OK". The ARGUS 
will continue to display “FAIL” until the 
measured value returns to a value less 
than the limit value once again.

<Edit> Edit the marked channel,
For information on changing 
the individual parameters, see 
page 174.

<Channel> Select a new channel

<Status> Display the Status screen withou
stopping the test.

<Total> Display all of the IPTV statistics.

Cancel the test.

Initialization

IPTV test

Continuation on 

next page
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Display:

Display:

Display:

- Current RTP-bitrate

- Number of packets lost during the 
test

- Display the packet loss ratio as a 
percentage

<Detail> Open the IPTV details

- Display the selected station name

- Display the test duration

- Display the IP address of the station

- Display the port of the station

- Display the DSL-CRC error counter 
(not on Ethernet), see page 39.

<Detail> Open the RTP details

- Current bitrate

- Current number of RTP packets

- Number of packets lost during the test

- Display the packet loss ratio in 1 s as a 
percentage

- Display the packet loss ratio as a 
percentage

- Display the DSL-CRC error counter 
(not on Ethernet), see page 39.

<MPEG2> Open the MPEG2 details, see 
page 179.

Continuation on 

next page
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Display:

Display:

Display:

Close the results display

For information on saving the results, see 
IP Ping page 126.
For information on sending the trace file to 
a PC (see page 126).

- Total CC error

- Display the DSL-CRC error counter 
(n/f)

<Info> Open the IPTV info

- Display the minimum bitrate in Mbit/s

- Display the maximum bitrate in Mbit/s 

- Display the average bitrate in Mbit/s

- Display RTP loss ratio as a percentage

Stop the IPTV test

IPTV results

Save the result?
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17.2 IPTV Scan

The ARGUS will check the availability of the TV broadcaster. The ARGUS will also show 

the zapping time between the TV broadcasters.
Up to three user-defined "Scan profiles" can be created. The following parameters, which 

are stored in a profile, are required to perform an IPTV scan (if a xDSL or Ethernet 

connection has already been setup, the connection parameters, e.g. the ADSL mode and 

the rated value, are blocked):

Protocol-independent parameters:

ARGUS - Status screen.









<Edit> Assign Virtual Lines to the 
IPTV service.

<Profile> Profile settings are like those 
for ADSL, see page 30.

<Start> Start service

Select a profile for editing. The 
selected profile will be marked blue 
in the display. The default profile 
will be marked in the display with a 

. The ARGUS will use the 
parameters in the default (preset) 
profile to setup the Ethernet or 
xDSL connection and for the IPTV 
scan.

The ARGUS will use the marked 
profile as the default profile and 
return to the Settings menu.

Continuation on 

next page

Test parameters

IPTV scan
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A total of 3 user-defined Scan profiles can 
be configured.







Edit the marked Scan profile.


View and edit the marked 
parameters if necessary
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IPTV Scan settings:

Setting Explanation

Test parameters:

IPTV scan: Up to 3 user-defined Scan profiles can be created. 
<Edit> The selected profile will be opened for editing.

Channel 
selection

The channel list can be used and edited for all profiles. Up to 250 

channels can be created. A configuration can also be conveniently 

prepared using the WINplus software on a PC.
Selection of the TV test channels for the IPTV scan:

The ARGUS will first display the TV 

channels that have already been selected 

in the order that they will be tested in an 

IPTV scan. If no channels have been 

select so far, the list will initially be empty. 

The places in the list can be filled one 

after the other. Up to 250 channels can be 

selected. 
<Insert>  A list of the available channels 
                  will open.







<Edit>

Mark the channels.
Channels, which have 
already been selected, will 
no longer appear in the 
channel list (see Display 
Channel selection).



Open marked channel for 
editing:
- Enter the address 
  (multicast IP and port 
  number) of the TV 
  channel
- Enter any alias name 
  desired for the TV channel 
  (e.g. station name).

Continuation on 

next page
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Add the selected TV channel (in the 

example, IPTV channel 4) to the Channel 

selection and then add the next channel 

(in the example, IPTV channel 5).
If two or more channels have been added 

to the list, their order can be changed 

using the following softkeys:

<Delete> Delete the marked TV 
channel from the list.

<Insert> Open the channel list 
showing the channels 
available.


Switch between softkey sets

<> The marked channel will be 
moved down one place in 
the list.

<> The marked channel will be 
moved up one place in the 
list.

IGMP version Version of the management protocol to log on/off of a multicast group 

(broadcast TV only).
Range: 2 to 3
Default setting: 3

Continuation on 

next page

Accept channel selection in 
the order shown
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Max. zapping 
time

Enter the zapping time (IPTV timeout): 
The zapping time is the period of time that elapses between 

requesting and receiving a IPTV channel. 
If the measure zapping time exceeds the value entered here, the 

ARGUS will consider the test to have failed and will display the 

message "Failed".
Range: 1 to 25 seconds
Default setting: 5 seconds

Profile name Entry of a name for the IPTV scan profile
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Start the IPTV Scan

Set up the service.


The profile used to set up the xDSL 
connection (in this example, Profile 1) will 
also be used for IPTV.



Activate the IPTV service.




If no xDSL connection has been setup, a 
connection will be setup automatically at 
this point using the default profile (see 
page 36).













<Edit> Assign a Virtual Line to the IPTV 
service or edit it.

<Info> Duration of the activation

<Test> Open test selection

<Stop> Deactivate service

<Profile> Display the IPTV scan profile, 
see page 181.

Continuation on 

next page

Initialization
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The IPTV scan will start automatically.

Display of the zapping time (time required 
to switchover) between the TV channels. If 
it is not possible to establish reception of a 
TV channel within the time period set (see 
page 184), the ARGUS will display 
"Failed".

Display of the minimum, maximum and 
average zapping time.



Close the results display.



For information on saving the results, see 
IP ping page 126.
For information on sending the trace file to 
a PC (see page 126).



<Status> Display the Status screen 
without stopping the test.

IPTV Scan

Save the result?
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17.3 IPTV Passive

The ARGUS listens for TV channels without requesting one. 
If the ARGUS detects TV channels, it will display a list of multicast IPs or channel names.


Instead of a PC or STB, you can also connect a second ARGUS in STB mode.

For more on protocol-independent parameters and test parameter settings for the 
IPTV passive test, see page 173 f.









Patch cablexDSL connection cable

LANLine jack

Ethernet xDSL 

  xDSL
Access

PC with VLC
(Video-LAN 

Client)

Set-Top-Box 
(STB)

alternatively

passive 

passive 

Ethernet 

active 
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Start IPTV passive
Set up the service.

The profile used to set up the xDSL 
connection (in this example, Profile 1) will 
also be used for the IPTV passive test.













Router mode started.











The IPTV service and Router mode are 
active and the ADSL connection is 
synchronous.

<Info> The duration of the router's 
activity will be displayed.

<Stop> Stop Router mode.

Continuation on 

next page

Use the cursor to 
select and activate the 
IPTV service.

Use the cursor to 
select and activate the 
router.
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el.

t 











The ARGUS will automatically check 
whether IPTV streams are available and 
display those that are.


In this example, 3 streams are displayed.

During the test, the ARGUS displays the 
selected IPTV channel, the duration of the 
test and the current bitrate. If the 
measured values exceed the threshold 
limits in the settings, the ARGUS will 
report that the IPTV test failed (FAIL); 
otherwise it will display "OK". The ARGUS 
will continue to display “FAIL” until the 
measured value returns to a value less 

than the limit value once again.

<Profile> Display the IPTV passive 
settings, see page 174.

<Refresh> Refresh the channel list

<Status> Display the Status screen 
without stopping the test.

<IP> Display the multicast IP of the 
selected channel.

<Channel> Select a different available chann

<Status> Display the Status screen withou
stopping the test.

<Total> Display all of the IPTV statistics.

Cancel the test.

Initialization

Continuation on 

next page

Waiting for stream
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18 Copper Tests

In the Access Menu, you will find an entry for "Copper Tests". These tests are used to 
examine the physical properties of the line tested.
The use of the various functions is described briefly below. Since the results are generally 
only presented in graphic form and as correct interpretation of the results also requires 
certain knowledge of the line measured, detailed instructions on the interpretation of the 
results would spring the bounds of this manual. To facilitate interpretation of the results, the 
ARGUS supports various aids, such as e.g. the Zoom and Cursor functions.

18.1 DMT Analysis

Using DMT Analysis (Discrete Multitone Transmission), the ARGUS can examine the 
spectral density (PSD - Power Spectral Density) of individual tones on a line.

 

18.1.1 Start DMT Analysis

Access

Copper Tests

Continuation on 

next page

ARGUS - Main Menu


Select Copper Tests



ARGUS State Display
Any DC voltage on the line will be dis-
played.


 

<Config>

<Menu>

<Start>



The voltages on the subscriber line may not exceed 200 VDC or 
100 VACpp.

For information on changing 
the DMT Analysis settings, see 
page 193.

Open the Main Menu.

Open the Single Tests Menu 
directly
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Continuation on 

next page




Select DMT Analysis:

The selected Copper Test will start as 
soon as it is selected.


Mode of operation in the DMT Analysis:
The DMT Analysis can be operated in the following mode:

Low-impedance Input impedance: 100 

Low-impedance mode:
In this mode, the ARGUS is connected at one end of the line as a terminal. For this mode, 
the line must be separated on at least one end. See following example.

Low-impedance example:

In this mode, it is possible to, for example, determine the noise on a quiet line or whether 
there is permanent interference on the line. In this manner, it is possible to determine which 
line in a cable bundle has the lowest quiet line noise. 

In the case of permanent interference 
(see the display in the example), one 
might find that the source is RF from a 
defective plug-in power supply coupled to 
the idle line. 

It is also possible to detect the effect of 
crosstalk from a neighbouring line on the 
idle line.

<Menu>

<New>

Open the Graphic functions, 
see page 194.

Starts a new recording.
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. 
DMT Analysis ARGUS State Display
A DMT Analysis is not performed in real-
time. Once the DMT Analysis has been 
started from the "Single Tests" Menu, it will 
record (depending on the presets - in this 
example the mode "All") one after the 
other the average (green), the peak/
maximum (red) and the bottom/minimum 
(blue) signal traces for the duration of the 
measurement. 
The results are presented in the form of a 
graph. A new measurement will first be 

done after the <New> softkey is pressed.

<New> 

or

The settings - determining the conditions under which the DMT Analysis will record 
something - can be configured before a test is performed.

Edit the marked parameters if 
necessary


ARGUS State Display






<Config>

<Menu>

<Start>   






Preset the 
 - Mode
 - Tones







Start a new measurement
(any previous recordings will 

be lost).

Change the DMT Analysis settings

Open the Main Menu.

Open the Single Tests Menu 
directly
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Mode

Tones

Setting Explanation

DMT Analysis:

The mode can be used to set which signal trace in the graph should be 

recorded by the DMT Analysis. Choose between:
 - Average measurement: 
   Shows the mean value measured during the measurement time set 
   (Frames: 128, Time: 250 ms), shown in green in the graph
 - Peak measurement: 
   Shows the peak value measured during the measurement time set 
   (Frames: 2048, Time: ca. 4 s), for each carrier frequency in red in the graph 
 - Bottom (minimum) measurement:
   Shows the minimum value measured during the measurement time set 
   (Frames: 2048, Time: ca. 4 s), for each carrier frequency in blue in the graph
 - All (Average, Peak and Bottom will be recorded)
Default setting: Average

The frequency range to be recorded is determined using the Tones setting. 
The DMT Analysis can record a maximum frequency range of 130 kHZ to 30 

MHz. In such case, the resolution is the usual tone interval, i.e. 4.3125 kHz, 

with a precision of ±1%.
The power measurement range is fixed at -140 to -40 dBm/Hz. It cannot be 

changed.
The following selected frequency ranges can be preset for measurements on 

a DSL line:
 - 1.1 MHz (ADSL), 130 kHz to 1.1 MHz
 - 2.2 MHz (ADSL2+), 130 kHz to 2.2 MHz
 - 8.8 MHz (VDSL2 8a), 130 kHz to 8.8 MHz
 - 17.6 MHz (VDSL2 17a), 130 kHz to 17.6 MHz
 - 30.0 MHz (VDSL2 30a), 130 kHz to 30.0 MHz
 Default setting: 1.1 MHz (ADSL)
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f 
18.1.2 Graphic functions

DMT Analysis State Display 
The graphic functions like Zoom and 
Cursor allow detailed analysis of the 

graphs.

<New>
or

<Menu>



To save the results and quit the DMT Analysis press the -key in the 

State Display (i.e. the display showing the graph).  

Zoom:

The Graphic functions menu will open.

The magnifying glass is shown in the 
display on a gray background. Zoom is 
active. If the magnifying glass is shown in 
the display on a white background, Zoom 
is not active.

<Zoom(x)-->

<Zoom(x)++> Not yet zoomed. Deactivates 
<Zoom(x)++>  and ceases 
enlargement.

Using the  it is possible to switch the function of the softkeys and select either x-axis 

zoom or y-axis zoom, see page 44 and page 44.

Start a new recording (any previ-

ous recordings are lost). 

Open Graphic functions.

Exit menu without making 

changes

Using these numeric keys the 

Zoom function can also be acti-

vated within a graph. 

The Cursor function is described 

on page 195.

Confirms the selection and 

returns to the graph.

Enlarges the central section o
the graph (100 %)
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Cursor:

average

peak


Once the Cursor function is started, a 
green Cursor line will be displayed in the 

middle of the graphic.

<Cursor>



The value of the graph at the cursor's cur-
rent position will be displayed below the 
graph (first example) as follows:
x:

y:

Using the "left" and "right" 
cursor keys, the cursor can 
be moved to any location in 
the graph to measure it. 
Briefly tapping the cursor key 
will move the Cursor one 
position further in the graph. 
The Cursor will move in ever 
larger steps if you press and 
hold the cursor key down.



The Zoom and Cursor functions can also be used in combination. As an example it is 
easier to measure a specific point in a graph with the Cursor function if you have first 
Zoomed in on the area. The zoomed area will not necessarily be centered on the Cursor.

Using the Cursor softkey, it is 
possible to switch the cursor on 
or off as needed once it has 
been activated from the menu. 
By default the Cursor will be 
first placed on the middle trace 
(green, "average") in the graph. 
Pressing the softkey again will 
move the Cursor to the 
maximum trace (red, "peak") 
and when pressed again to the 
minimum trace (blue, "bottom") 
in the graph.

+8.832 MHz (precision: ±1 %)

-83 dBm/Hz (precision: ±2 %)
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Tones:

Mode:



Set the frequency range (see page 193).



The smaller the frequency 
range, the faster the DMT 
Analysis will be performed.


Open the Tones menu








Set the signal traces to be displayed (see 
page 193).


The fewer the traces to be 
recorded, the shorter the 
recording time.


Open the Mode menu.
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19 Test Results

 

19 Test Results

The saved test reports can be viewed either on the ARGUS display or on a PC. The test 

data can be sent to a Windows PC, where - using the WINplus software - it is possible to 

generate - among other things - a comprehensive test report.
The ARGUS saves the test results together with the date and the time (ARGUS internal 

clock, see page 203) in one of the 50 sequentially numbered (1, 2, 3, etc.) memory 

locations. The ARGUS will suggest "AMP_x" as a name where the "x" in this case 

represents the current memory location. If all the settings are reset, the test results that 

have been saved will also be deleted. The functions ("View", "Test data to PC", "Delete") in 

the Test results menu refer to a test result. Therefore, a window will open first showing a list 

of the reports saved.



ARGUS - Main Menu.


The ARGUS will display for each memory 
location the corresponding name of the 
memory location as well as the date and 
time. Empty memory locations are labeled 
as "empty".

<Date> The date and time that the results
were saved will be displayed.
The <Name> softkey will also be 
displayed.

<Name> Display the name of the memory 
location.

Test results
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19.1 Saving Test Reports


The results of a test can be saved when a 
test is completed or when a connection is 
cleared down.






The ARGUS saves the test result in the 
first available memory location. If the 
memory is full, you must manually select a 
memory location to be overwritten.

As names for the memory locations, the 
ARGUS will suggest either AMP_1, 
AMP_2, AMP_3 etc.

The name shown can accepted or a new 
one can be entered using the keypad. 
When the right softkey is pressed, it 
assumes a different meaning and thus 
influences the entries made from the 
keypad. Up to 24 characters can be 
entered.

<12>ab> Entry of the digits 0 to 9 plus * 
and #

<ab>AB> Entry of lowercase characters 
(e.g. to enter a “c” press the 
“2” on the keypad three times), 
plus @, /, -, and .

<AB>12> Entry of the uppercase 
characters and @, /,- and .

<Delete> Delete the character before 
the cursor

Move the cursor

Do not save the results;
return to the previous display.Store the result
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19.2 Displaying the Saved Test Reports



ARGUS - Main Menu












19.3 Test Results – Sending to a PC

The test results can be sent to a PC, where they can be visualized and archived. Use the 

included USB cable to connect the ARGUS (ARGUS “USB-B” jack) to a USB jack on your 

PC and then start WINplus on your PC.



ARGUS - Main Menu.

Select a memory location
(In this example, the first memory 
location named AMP_1 has been 
selected).

Select a memory location
(In this example, the first memory 
location named AMP_1 has been 
selected).
All of the test results will be sent.

Test results

1 AMP_1

View

Display the test 

report

Test results

1 AMP_1

Test results to PC

Start transfer of test results to PC
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19.4 Test results – Deleting



ARGUS - Main Menu



Delete the test report stored in the 
selected memory location.

The memory location will again be 
marked as "empty".

For information on how to delete all test 
results, see on page 207 “Reset Settings 
to Factory Settings”.

19.5 Send All Test Results to a PC

The ARGUS sends all of the saved test results to the PC. Connect the ARGUS to your PC 

and start WINplus on the PC.



ARGUS - Main Menu









Select a memory location
(In this example, the first memory 
location named AMP_1 has been 
selected).

Select one of the stored test 
reports (in this example, the test 
results stored in the memory 
location named AMP_1).

Test results

1 AMP_1

Delete

1 empty

Test results

1 AMP_1

All tests to PC

Start transfer of data to PC
200 ARGUS 141 



19 Test Results
19.6 Delete All Test Reports

The ARGUS will delete all of the test reports stored in the internal memory. 















Select one of the memory 
locations with stored test results 
(in this example, the memory 
location named AMP_1).

Test results

1 AMP_1

Delete all

Press <Yes> to confirm that you 

really do want to delete all of the 50 

possible test reports.
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20 ARGUS Settings
20 ARGUS Settings

The ARGUS can be configured to suit special requirements. The default (factory) settings 

can be restored by selecting "Reset“ (see page 207).

20.1 Trace/remote

The ARGUS passes the recorded data online directly to the connected PC.



ARGUS Main Menu






The default (preset) Trace mode will be 
marked in the display with a .




If the ARGUS cannot send the data to the PC without errors, the “PC” LED will flash at 5Hz 

(5 times per sec).

Mark the desired Trace mode The 
selected Trace mode will be 
marked blue in the display. 

Open the next higher menu without 
making any changes.

Off Basically, the data will not be sent to the PC.
Default setting: off

Auto PC sync. All data will always be sent to the PC (“PC” LED will flash). 
This setting remains active even after the ARGUS is 
switched on again.

Manual PC sync. Data will be sent to the PC until the ARGUS is switched off 
(the "PC" LED will flash). When the ARGUS is switched off 
and then back on again, Trace mode will be off. 

Settings

Trace/remote

The marked Trace mode will be 

activated as the default setting. 

Off
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20.2 Device Settings

The procedure for configuring a device setting will be illustrated with a single example: 

"Alarm bell".



ARGUS - Main Menu





Using the cursor keys, select a setting 
(e.g. Alarm bell).

The default setting will be marked in the 
display with a .




Mark the desired setting. The 
selected setting will be marked blue 
in the display. 

Open the next higher menu without 
making any changes to the 
settings.

Setting Explanation

Menu 
language

Selection of the menu language.
Default setting: depends on country

LCD 
lightness

Setting the display contrast: The contrast can be changed in 16 steps. The 
contrast can be increased or decreased using the cursor keys. The 
display shows a vertical arrow, which shows the current setting on a scale 
from low to high contrast. 

Date / 
Time

Entry of the date and time (initialisation of the internal clock) via the 
keypad. Use the vertical cursor keys to scroll from line to line in the 
display. The entered time will be continuously updated by the ARGUS’s 
real time clock as long as the power is not interrupted. If the ARGUS 
switched off without batteries, the clock will still run a few more days on its 
own internal supply. If the backup supply is exhausted, the time will be 
undefined and must be set again.

Settings

Device

The marked setting will be 

activated as the default setting. 

Off

Alarm bell
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Ringer
volume

With this setting you can set the volume level used by the ARGUS to 
signal an incoming call.
The initial volume level can be set.
- Default setting: Level 1 (very quiet)
In addition, you can also set the end volume level.
- Default setting: Level 7 (very loud)
When an incoming call is received, the ARGUS will begin signalling with 
the initial (very low) volume and increase the volume by one increment 
each time it signals until it has reached the final (very loud) volume.

Alarm bell The ARGUS signals with an audible alarm in a variety of situations, e.g. 
when a bit error occurs in a BERT or the ARGUS has synchronized on an 
xDSL access or when an error counter increments.

When this setting is set to "off“, all audible alarms are suppressed.
Default setting: off

Jingle After the tester is switched on and has initialized, it will indicate its 
readiness by sounding the ARGUS jingle.
Default setting: off

Power 
management

Switch off automatically: Set how long the ARGUS can remain idle before 
the power management will switch to power down mode if the ARGUS is 
not connected to the plug-in power supply. If power management is 
disabled, the ARGUS will display a message, when it is switched on, 
warning that this will lead to a shorter battery life. This notice can be 
deactivated by pressing the "X"-key. 
By pressing <On>, you can reactivate this notice.
Default setting: after 5 minutes

Lighting: Sets how long the background lighting will remain on. When 
operated from the mains power, the background lighting will always 
remain on. When operating from the battery pack, the ARGUS switch off 
the background lighting after the set time.
Default setting: off after 30 seconds

Software 
option

Enabling a software option the associated key code must be entered via 
the keypad. Additional ARGUS options can be enabled if desired by 
entering the associated 20-place code on the keypad.
To obtain this code, please contact us.

short - long Synchronized successfully

long - short Synchronization lost 

short - short Error counter incremented (The alarm refers to the last 
second only. Only one alarm is signalled even if there 
were several errors.)
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20.3 Settings  –  Backup / Restore

The ARGUS can backup and when needed restore all of its settings (PPP user name, PPP 

password, IP addresses, profile names, etc.).

Saving settings



ARGUS - Main Menu









All of the ARGUS settings made will be 
backup and can thus be restored at a 
later time.




Settings

Backup/Restore
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20 ARGUS Settings
The settings can now be backed up and 
restored again later should this be 
needed. 

Restoring settings
Select Restore settings.



The backed up configuration will now be 
restored.

To backup or restore the settings, 
you must first enter the safety 
key.
To request the safety key, contact 
your support (sales partner) or 
intec directly (see page 8).

Restore the backed up 
settings.

If no settings have been 
saved, this function has 
the same effect as 
"Resetting to Factory 
Settings“, see page 207. 
The saferty key is not 
required.

Restore now?

<Yes>

and
206 ARGUS 141 



20 ARGUS Settings
20.4 Reset Settings to Factory Settings 

The ARGUS will reset all settings to the original factory settings.

The speed-dialling memory with the call numbers, PPP user name, PPP password, 

IP addresses, profile names and all of the test results stored in the ARGUS will be 

deleted.









All settings will be reset to their factory 
settings.








The ARGUS will 
immediately display the 
security warning query "All 
settings will be reset to the 
factory settings! All test 
results will be deleted!
Reset now?“

Please contact your support 
(sales partner) or intec directly for 
the safety key (see page 8).

Settings

Backup/Restore

The following steps are performed 

in the same manner as in "Back up 

configuration", see page 205.

and
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21 Using the Battery Pack

Changing the battery pack

Switch the ARGUS off and disconnect the plug-in power supply. Afterwards, loosen the 

thumbscrew to release the battery pack.

Battery pack handling 

The ARGUS may only be operated with the included battery pack. Connecting any 

other voltage supply to the contacts in the device will damage the ARGUS.

Automatic recharging of the battery pack when the ARGUS is switched off

The ARGUS automatically recharges the battery pack, if the ARGUS is connected to the 

plug-in power supply and is switched off and the battery pack voltage is too low. While 

charging, the ARGUS displays the message “Charge battery”. If you press and hold the 

power switch, the ARGUS will switch off before the battery pack is recharged. The ARGUS 

remains on after fully recharging the battery pack.

- The supplied battery pack may only be charged in the ARGUS.

- Do not use the supplied battery pack in other devices.

- The ARGUS battery pack may only be actively charged (Charge battery) or trickle 

charged (default setting: on) when the ambient temperature is between 0 °C (32 °F) 

and +40 °C (104 °F). 

- Recharge the battery pack fully at least once a month (even if the ARGUS is not used 

for a longer period of time).

- If the lithium-ion battery pack is stored, it should first be charged to between 40 and 

60 % of its capacity. If the lithium-ion battery pack is stored for a longer period of time, 

it should be recharged to this level every six months.
To maximize the service life of a battery pack, if it is to be stored over a longer period 

of time, it should not be exposed to temperatures in excess of +50 °C (95 °F).

- Please read the extensive notes on safety and the transport of the lithium-ion battery 

pack found in the section "Safety Instructions" (see page 9).
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Charge battery

The ARGUS will display the current charge of the battery pack graphically, if no power 

supply is connected. A battery symbol on the display will begin to blink, when there is still 

approximately (depending on the mode of operation) 8 minutes reserve. During this period, 

it is possible that there may be audible interference and in rare cases even malfunctions. 

Connect the power supply.
When the plug-in power supply is connected, the battery pack in the ARGUS can be fully 

recharged. It is not necessary to manually discharge the lithium-ion accumulators in the 

ARGUS battery pack. It may take up to 6 hours to fully recharge the battery pack.



ARGUS Main Menu



Connect the power supply!
The charging process begins.
The ARGUS will display the voltage while 
charging the battery pack.




Automatic recharging of the battery pack in the background (trickle charge)


ARGUS Main Menu






If the battery voltage is too low, the 
ARGUS will charge the battery pack 
automatically in the background when the 
plug-in power supply is connected 
(battery symbol shown on the display).




If the ARGUS is disconnected from the power supply before the battery pack is fully 

recharged, the ARGUS will not automatically begin to charge the battery pack 

again when it is reconnected to the power supply, since the battery voltage is no 

longer less than the threshold value.

Charge battery

Charge

Charge battery
U: 4.03V

Charge battery

Auto charge

On

The ARGUS uses 

this setting and returns to the next 

higher menu.
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22 Firmware Update

You can download a firmware file from www.argus.info/service free-of-charge and save it 

on your PC to later transfer to your ARGUS tester.
Open the Internet site www.argus.info:

Click on "Service" (shown here in blue) in the navigation bar.







This will open the product list:








Select the model of your 

ARGUS.

After this page opens, 
click on "Downloads" 
in the "Service" column 
on the left. 
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After you have selected the type of device, the page showing the relevant firmware updates 

will open. On this page, you can select the firmware variant for your specific country.

After you have selected the required variant, a browser window will open to permit you to 

select the location where the firmware should saved on your PC. The remaining steps are 

explained in the WINplus manual and in the guide for the Update Tool

Important information regarding the ARGUS Firmware Update:

Do not, under any circumstances, start to update the firmware if the ARGUS is 

running on its battery pack. First connect the ARGUS to the plug-in power supply, 

before sending the firmware update file from your PC to the ARGUS. An ARGUS 

USB cable is required to perform an update (USB cable with a mini-USB plug). 

Save the configuration and test reports on a PC before beginning an upgrade. Do 

not disconnect the ARGUS from the PC during the update. Do not switch the 

ARGUS off while an update is being performed. You must also pay attention to the 

messages on the ARGUS display – not just the instructions displayed by the 

Update Tool on the PC. The update has not been successfully completed until the 

Update Tool displays a corresponding message on the PC and the ARGUS – after 

being automatically restarted by the Update Tool – shows the normal startup 

screen.
The ARGUS will not switch on until after you have clicked on one of the two 

buttons ("back to step 1" or "Exit program") on the Update Tool after the update 

has been completed. 
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A) Acronyms 

Characters

 Ohm (electrical resistance)

A

A Ampere (unit of electrical current)

AC Alternating Current or also an abbreviation for ACcess server

ADSL Asymmetric Digital Subscriber Line

AMP ARGUS measurement report

ANSI American National Standards Institute

Anx. Annex

ASCII American Standard Code for Information Interchange.

ATM Asynchronous Transfer Mode

ATU-R ADSL Transceiver Unit - Remote

Auto-MDI-X Automatic Medium Dependent Interface Crossing

Avg Average

B

BR Bridge

BRAS Broadband Remote Access Server

C

C Celsius

c0 Speed of light

CO Central Office 

CRC Cyclic Redundancy Check

D

dB Decibel

dBm/Hz Unit of power referenced to 1 mW (milliwatt) per Hertz

DC Direct Current

DHCP Dynamic Host Configuration Protocol

diffserv Differentiated Services

DIN Deutsches Institut für Normung e. V. (the German Institute for 

Standardization)

DL Download

DMT Discrete Multitone Transmission

DNS Domain Name System

DPBO Downstream Power Back Off

DS Downstream band

DSL Digital Subscriber Line

DSLAM Digital Subscriber Line Access Multiplexer
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E

e.g. Example 

EU European Union

ElektroG Elektro- und Elektronikgerätegesetz (German Electrical and Electronic 

Equipment Act)

EMV Electromagnetic Compatibility

EN European Norm

EoA Ethernet over ATM

ete end-to-end 

ETH Ethernet

ETSI European Telecommunications Standards Institute

F

FEC Forward Error Correction

FS Feature Set

FTP File Transfer Protocol

FW Firmware

H

h hour

HDB3 High Density Bipolar of order 3

HEC Header Error Checksum

HEX Hexadecimal

HLOG Amplitude component of the transfer function for each tone

HTTP Hyper-Text Transfer Protocol

Hz Hertz (unit of frequency - 1 cycle per second)

I

i. e. in example

IAD Integrated Access Device

ID Identifier

IEEE Institute of Electrical and Electronics Engineers

IGMP Internet Group Management Protocol

INP Impulse Noise Protection

IP Internet Protocol

IPCP Internet Protocol Control Protocol

IPoA Internet Protocol over ATM

IPoE Internet Protocol over Ethernet

IPTV Internet Protocol Television

ISO International Standard Organization

ISP Internet Service Provider

ITU International Telecommunication Union

K

KB Kilobyte
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Kbit/s Kilobits per second

L

L1 Layer 1 in the OSI reference model

L2 Layer 2 in the OSI reference model

L3 Layer 3 in the OSI reference model

LAN Local Area Network

LCD Liquid Crystal Display

LCP Link Control Protocol

LED Light-Emitting Diode

LOS Loss of Synchronization

M

m meter

MAC Media Access Control

MB Megabyte

Mbit/s Megabit per second

MDI Media Delivery Index (RFC 4445)

MLR Media Loss Rate

min. minute

Modem Modulator/Demodulator

MOS Mean Opinion Score

MPEG Moving Picture Experts Group

MTU Maximum Transmission Unit

mVpp millivolt peak-to-peak

N

n/a not available

n/r not received 

n/u not used 

NAT Network Address Translation

NGN Next Generation Network

NTBA Network Termination for ISDN Basic rate Access

O

OAM Operations, Administration and Maintenance

OoS Out of Sequence (OOS)

OSI Open Systems Interconnection

P

PADI PPPoE Active Discovery Initiation

PADO PPPoE Active Discovery Offer

PADR PPPoE Active Discovery Request

PADS PPPoE Active Discovery Session confirmation

PADT PPPoE Active Discovery Termination

PAP Password Authentication Protocol
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PC Personal Computer

PCR Program Clock Reference

PDU Protocol Data Unit

PID Packet Identifier

POTS Plain old telephone service (PSTN - public switched telephone network)

P-P Point-to-point

P-MP Point-to-multipoint

PPP Point-to-Point Protocol

PPPoA Point-to-Point Protocol over ATM

PPPoE Point-to-Point Protocol over Ethernet

PPTP Point-to-Point Tunneling Protocol

PSD Power Spectral Density

PSI Program Specific Information

PWR Power

Q

QLN Quiet Line Noise

QoS Quality of service

R

RC Resistance (R) and capacitance (C)

RFC Request for Comments

RJ Registered Jack (standardized jack)

RoHS Restriction of Hazardous Substances

RT Router

RTCP Real-Time Control Protocol

RTP Real-Time Transport Protocol

RTSP Real-Time Streaming Protocol

Rx Receive

S

s second

SBC Session Border Controller - Outbound Proxy

SIP Session Initiation Protocol

SNR Signal-to-Noise-Ratio

SNRM Signal-to-Noise-Ratio Margin

STB Set-Top Box

STUN Session Traversal Utilities for NAT

T

T Trigger

TCP Transmission Control Protocol

TE TErminal, Terminal Equipment

TM Test Manager

ToN Type of Number
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ToS Type of Service

TS Technical Specification

TTX Teletext

Tx Transmit

U

UDP User Datagram Protocol

UL Upload

URI Uniform Resource Identifier

URL Uniform Resource Locator

US VDSL: Upstream band

USB Universal Serial Bus

V

V Volt (unit of electrical voltage)

VC Virtual Channel

VCC Virtual Channel Connection

VCI Virtual Channel Identifier

VC-MUX Virtual Circuit Multiplexing

VDSL Very High Speed Digital Subscriber Line

VLAN Virtual Local Area Network

VL Virtual Line

VLC Video LAN Client

VoD Video on Demand

VoIP Voice over Internet Protocol

VPI Virtual Path Identifier

Vpp Volt peak-to-peak 

VTU-R VDSL Transceiver Unit - Remote

W

WAN Wide Area Network

WEEE Waste Electrical and Electronic Equipment

X

xDSL Collective term for different DSL variants

xTU-C xDSL Transceiver Unit - Central Office

xTU-R xDSL Transceiver Unit - Remote

Z

Z Impedance
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B) Vendor identification numbers

Abbreviation Manufacturer

ALCB Alcatel (STMicroelectronics)

ANDV Analog Devices

BDCM Broadcom

GSPN Globespan

IKNS Ikanos

IFTN Infineon

META Metanoia

STMI STMicroelectronics

TSTS Texas Instruments
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C) 

Negotiation err

Idle release

Time out rel

PPP: Echo req. 
error

Hanging up rel

Loopback erro

Authent. Error

PADO timeout

PADS timeout

Error message: PPP connection

ARGUS Display Description

External fault:

Cannot negotiate the network protocol for PPPD, so the remote 
site is not reachable.

Connection was terminated, since there was no activity.

Connection was terminated, since the maximum connection time 
elapsed.

Remote site did not answer echo requests so the connection has 
been terminated. (PPP connections are tested at regular intervals 
by sending echo requests to the remote site.)

Disconnected by remote site.

The setup of the PPP connection was cancelled, since a loopback 
was detected.

Authentication error: Wrong user name or password - rejected by 
remote site.

No PADO packets received.

No PADO packets received.
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D) Error message: Download test

Http redir.error

http: no response

Http serv.error

Http encod.error

Ftp open error

Ftp login error

Ftp passiv err.

Ftp rec. error

Network error

Ftp error

URL error

Socket error 2

Http Head.error

Ftp no file

Unknown address

Unknown download 
error



ARGUS Display Description

External fault:

Fault: Too many HTTP redirects.

No answer from HTTP server.

HTTP server has returned an error.
(for details see the table below "HTTP Error Messages")

Due to an encoding problem, data transfer with HTTP is not 
possible.

Error when opening the FTP connection.

FTP login error. Wrong user name or password or anonymous 
login not supported.

FTP server does not support passive transmission mode.

FTP receive error.

Network error

General FTP error.

Fault: No HTTP or FTP URL specified.

Error when connecting a socket. The server's HTTP service is not 
available.

Error in the header of the requested HTTP file.

FTP download error: No such file or directory found.

Unknown host address.
Possible cause: Error in the address entered, DNS resolution not 
working or network not accessible.

Unknown download error
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E) HTTP status codes:

Display on 
ARGUS:
Code No.

Meaning

100 Client should continue its request.

101 The protocol is being changed at the Client's request.

200 The Client's request has succeeded.

201 The Client's request that a new document be created was successful.

202 The Client's request has been accepted for processing.

203 The Client's request will be answered with information from a source 
other than the server.

204 The Client's request was successful. The server sends [no content] only 
the HTTP header.

205 The Client's request was successful. The server [resets content] sends a 
new HTTP body.

206 The Client's request was successful. The server sends only part of the 
requested document [partial content].

300 The request was not precise enough so multiple documents have been 
returned.

303 The requested resource has been found at a different URI and should be 
retrieved from there.

304 The requested document has not been changed in the interim.

305 The requested document must be retrieved from a proxy instead of from 
the server.

307 The requested resource has been temporarily relocated to a different 
URI [temporary redirect].

400 Syntax error in the Client's request [Client error].

401 The request requires user authentication.

402 Payment is required to process this request.

403 The Client's request has been refused. (e.g. because 
authentication failed.)

404 The requested document was not found (e.g. because of an error in the 
URL entered or while the document is no longer available).

405 The method specified by the Client in its request is not allowed by the 
server.

406 The requested document in a format that is not supported by the Client.

407 The request requires that the Client authenticate itself with a proxy.
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408 The Client did not place its request within the time allowed by the server 
[Request Timeout].

409 Due to a conflict (e.g.another request) the Client's request cannot be 
completed by the server.

410 The requested URL is [gone] no longer available on the server.

411 The Client sent data to the server without a defined Content Length.

412 The preconditions in the Client's request could not be satisfied by the 
server.

413 The Client's request has been refused by the server because the 
request entity is too large.

414 The Client sent a URL to the server that is too large 
(e.g. because of the form values contained).

415 The Client's data is not supported by the server.

416 The range (in a document) requested by the Client does not exist.

417 The server could not (or did not wish to) satisfy the Client's expectation 
given in the Expect request header field.

424 Due to a failed dependency, the requested document will not be sent by 
the server.

500 Due to an unexpected condition, the server cannot fulfill the Client's 
request (e.g. faulty configuration, missing or wrong CGI program).

501 The server does not support the function required to fulfill the Client's 
request.

502 The server received an invalid response from an upstream server or 
proxy which it accessed in attempting to fulfill the request.

503 The server is currently unable to handle the request due to a temporary 
overloading of the server.

504 The Client's request (of a gateway or proxy) did not receive a response 
within the specified time.

505 The server does not support the HTTP protocol version that was used in 
the Client's request.
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F) General Error Messages 

Prot. not supp.

Unknown error

No PPP connec.

Test aborted

Ping start error

Fault: PPP con-
nection

Unexp. PING end



Display on ARGUS Description

The protocol (IP, PPPoE, etc.) is not supported in the selected 
mode.

Unknown error occurred.

No PPP connection can be setup. 

Test aborted by user.

Error when starting the Ping test.

Unexpected termination of the PPP connection.

Unexpected termination of the Ping test.
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G) VoIP SIP status codes



SIP requests:

The six basic requests / methods:

INVITE Invite a user to a session (call - initiates a session)

ACK Acknowledge an INVITE request

BYE Terminate a session (hangup)

CANCEL Terminates the setup of a connection

REGISTER Provides data regarding subscriber availability (host name and IP address)

OPTIONS Supplies information regarding the functions supported by the other SIP 
telephone

SIP responses:

SIP responses are answers to SIP requests. There are six basic types of SIP responses 
with numerous sub-responses:

1xx Informational responses (180 indicates for example that the phone of the 
party called is ringing)

2xx Reports that the request has been successful

3xx Redirection responses

4xx Client failure responses

5xx Server failure responses

6xx Global failure responses

Display 
on 
ARGUS: 
Code No.

Meaning Explanation

100 Trying The ARGUS is attempting to setup a call.

180 Ringing The phone at the other end is ringing.

181 Call Being Forwarded The call is being forwarded.

182 Call Queued The call is in a wait loop.

183 Session Progress The call is being setup.

200 OK Everything is all right.

202 Accepted Connection has been accepted.
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300 Multiple Choices There is no unique destination address for 
the remote end. Please select one.

301 Moved Permanently Calls are being permanently forwarded.

302 Moved Temporarily Calls are being temporarily forwarded.

305 Use Proxy A proxy must be used.

380 Alternative Service Alternative service

400 Bad Request The request is not OK.

401 Unauthorized You are not authorized.

402 Payment Required Payment is required.

403 Forbidden This is not permitted.

404 Not Found The remote end was not found or does not 
exist.

405 Method Not Allowed The method (e.g. SUBSCRIBE or NOTIFY) 
is not permitted.

406 Not Acceptable The options used in the call are not 
supported.

407 Proxy Authentication Required The proxy must be authenticated.

408 Request Timeout The time for the request has been 
exceeded (timeout).

409 Conflict There is a conflict.

410 Gone The subscriber is no longer reachable here.

411 Length Required The length must be supplied.

413 Request Entity Too Large The values are too long.

414 Request URI Too Long The URI is too long. (Destination address)

415 Unsupported Media Type The codec is not supported.

416 Unsupported URI Scheme The URI scheme is not supported. 
(Destination address)

420 Bad Extension The extension is wrong.

421 Extension Required An extension is necessary.

423 Interval Too Brief There is a problem with the SIP 
parameters. 
(Register Expire is too short)

480 Temporarily Unavailable The subscriber is currently not reachable.

481 Call/Transaction Does Not Exist This connection does not exist (any longer).

482 Loop Detected A redirection loop has been detected.

483 Too Many Hops Too many redirects.

484 Address Incomplete The SIP address is incomplete or faulty.

485 Ambiguous The SIP address is not unique.

486 Busy Here The destination is busy.

487 Request Terminated The request has been terminated.

488 Not Acceptable Here The call cannot be accepted.

491 Request Pending A request is waiting.
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493 Undecipherable Decryption error.

500 Server Internal Error Internal error in the server.

501 Not Implemented The requested method (functionality) has 
not been implemented.

502 Bad Gateway The gateway is bad.

503 Service Unavailable The service is not available.

504 Server Time-Out The gateway did not respond in time.

505 Version Not Supported The SIP protocol version is not supported.

513 Message Too Large The message length is too long. Use TCP.

600 Busy Everywhere All terminals are busy at the remote end.

603 Declined The system at the remote end refused to 
accept the call.

604 Does Not Exist Anywhere This user does not exist any longer.

605 Not Acceptable SIP request not acceptable.
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H) Software Licenses

The ARGUS firmware includes code from what are known as Open Source packages, 

which have been published under various licenses (GPL, LGPL, MIT, BSD, etc.). 
Additional information can be found – if requested in your order – on the CD-ROM included 

in the package (see Software_License.htm) or can be viewed at 
http://www.argus.info/web/download/Software_License.
In the event that you are interested in the sources licensed under GPL or LGPL, please 

contact support@argus.info. A machine-readable copy of the source code can be obtained 

from intec Gesellschaft für Informationstechnik mbH for a minimal fee - to cover the cost of 

physically copying the code. This offer is valid for 3 years.
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